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About This Guide

This guide introduces the IBM® WebSphere® Business Integration (WBI) Workbench Server™ 
Deployment. It shows you how to extract the WBI Workbench Server necessary files and 
folders, install the necessary components, and deploy the WBI Workbench Server 
Application Server on IBM WebSphere Web Application Server.

Introduction: Introduction to WBI Workbench Server Deployment introduces how to install 
and deploy the WBI Workbench Server.

Chapter 1: WBI Workbench Server Machine Requirements lists the minimum and the 
recommended machine requirements for WBI Workbench Server.

Chapter 2: Creating the WBI Workbench Server Database Describes the required steps for 
creating and configuring the WBI Workbench Server database or upgrading the existing 
database to the recent version.

Chapter 3:  WBI Workbench Server Application Server Deployment shows how to deploy/
un-deploy the WBI Workbench Server Application Server automatically on IBM WebSphere 
Application Server.

Appendix A: Manual Deployment of WBI Workbench Server on WebSphere 4.0.2 shows 
how to manually deploy the WBI Workbench Server Application Server on IBM WebSphere 
4.0.2.

Appendix B: Manual Deployment of WBI Workbench Server on WebSphere 5.0 shows how 
to manually deploy the WBI Workbench Server Application Server on IBM WebSphere 
Application Server5.0 or IBM WebSphere Deployment Manager (Network Deployment).

Appendix C: Using the AdminWrite Utility describes how to use the AdminWrite utility in 
order to gather the required parameters needed for running the InstallServer utility.
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Introduction to WBI Workbench Server 
Deployment

The WBI Workbench Server is a Web application that is deployed on a Web 
Application Server. After you have installed the Web Application Server and 
deployed the WBI Workbench Server components, then you can access the 
WBI Workbench Server Web Application from anywhere through a Web 
browser.

The WBI Workbench Server also requires a database server to be installed. 
(IBM DB2® Universal Database™ Server, Oracle 8i Database Server, or MS 
SQL Server 2000). You may install the Database Server on the same machine 
as the Web Application Server or on another machine and install Database 
Client on the machine where the Web Application Server is installed and the 
WBI Workbench Server is deployed.

This guide lists the WBI Workbench Server’s machine requirements, also you 
will be guided step by step to deploy the WBI Workbench Server on the IBM 
WebSphere Application Server by using the manual and automated methods.

The following chapters provide details on the WBI Workbench Server’s machine 
requirements, how to properly create and configure the WBI Workbench Server 
database using the Database Configuration Utility named InstallServer Utility, 
and how to perform the procedure of deploying the WBI Workbench Server on 
IBM WebSphere Application Server on Windows, AIX® and Solaris platforms. 

 

The following conventions are used for all the instructions throughout this 
Guide: 

• On AIX and Solaris platforms, use forward slash / instead of back-slash \ 
when writing paths 

• Important note: The names and paths of folders and files are case 
sensitive. 

• Important note: Make sure that the user you are using have all needed 
permissions. For example, using a user who has no permissions on 
WebSphere or the Database will fail to deploy the WBI Workbench Server. 

• The following are a list of all abbreviations in the deployment steps:

*  <WBServerHomeDir> = The WBI Workbench Server home directory 
where you have installed the WBI Workbench Server using the 
Installation Wizard.. e.g. C:\Workbench_Server

*  <WBServerWorkDir> = The WBI Workbench Server working 
directory that will be created by the Automatic Deployment Wizard. 
e.g. C:\BPR423
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*  <ServerName> = The name of the server on which the WBI 
Workbench Server will be deployed. 

*  <WebServerName> = The name of the machine that hosts the Web 
server for which the WebSphere is configured. (Ex. The machine 
name on which the IBM HTTP Server or Microsoft IIS 4.0 or IIS 5.0 is 
installed) 

*  <WebSphere> = The WebSphere home directory. e.g. 
C:\Websphere\AppServer 

*  <DB2> = The path where the IBM DB2 is installed. (E.g. C:\SQLLIB) 

*  <ORACLE_HOME> = The path where the Oracle Database Server is 
installed. (E.g. C:\Oracle\Ora81) 

*  <SQLSRVR> = The MS SQL Server database server installation root 
directory

*  <SQLJDBC> = The MS SQL Server JDBC driver installation directory. 
(e.g. C:\Apps\SQL200JDBC) 

 

 4          IBM WBI Workbench Server - Deployment Guide



Chapter 1: WBI Workbench Server 
Machine Requirements

This section describes the current machine requirements for the WBI 
Workbench Server. This includes both the Server machine requirements and 
the client machine (s) requirements.
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1.1 Server Requirements
The following are the Hardware, Software and System requirements of the 
Server machine(s) where the WBI Workbench Server will be installed.

1.1.1 Hardware Requirements 
The Server hardware requirements are the same requirements as those for the 
Database Server and the Web Application Server. However, these are the 
minimum hardware requirements for the Server machine:

1.1.1.1 For Windows

• Pentium III 650 MHz or higher (recommended)

• 256 MB RAM (512 recommended)

• 100 MB of disk space, plus sufficient space for database

1.1.1.2 For AIX

• IBM RS/6000® Server

• 512 MB RAM, or higher

• 100 MB hard-disk space, plus sufficient space for database

1.1.1.3 For Solaris

• Sun Server

• 512 MB RAM, or higher

• 100 MB disk space, plus sufficient space for database

1.1.2 Software Requirements
FOR All platforms

• IBM WebSphere Application Server v4.0.2 Advanced Edition, or

IBM WebSphere Application Server v5.0 Application Server, or

IBM WebSphere Application Server v5.0 Network Deployment.

• IBM DB2 Universal Database version 7.2 with Fixpack 5 or higher, or  IBM 
DB2 UDB V8.1. Or

Oracle 8i Database Server release 8.1.7.1, or Oracle 9i. Or

MS SQL Server 2000

*  For MS SQL Server you have to download and install the MS SQL 
Server JDBC Driver. You can download the driver from the following 
location:
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http://www.microsoft.com/sql/downloads/default.asp

You have to perform the following steps after you downloaded and installed the 
MS SQL Server JDBC Driver and before using it in order to use the MS SQL 
Server JDBC distributed transactions through JTA. This must be repeated for 
each SQL Server installation that will be involved in a distributed transaction. 

1.   Copy the file sqljdbc.dll from <SQLJDBC>\ SQLServer JTA directory to 
the <SQLSRVR>\bin directory. 

2.   From the server, use the ISQL utility to run the instjdbc.sql script. The 
system administrator should back up the master database before 
running instjdbc.sql. 

3.   At a command prompt, use the following syntax to run instjdbc.sql: 

ISQL -U sa -P sa_password -S server_name -i location\instjdbc.sql

Where: 

- sa is the user name of the system administrator

- sa_password is the password of the system administrator. 

- server_name is the name of the server on which SQL Server resides. 

- location is the full path to instjdbc.sql. This script is located in the MS 
SQL Server JDBC Driver install_dir/SQLServer JTA directory. 

The instjdbc.sql script generates many messages. In general, these 
messages can be ignored; however, you should scan the output for any 
messages that indicate an execution error. The last message should 
indicate that instjdbc.sql ran successfully. The script fails when there is 
not enough space available in the master database to store the JDBC 
XA procedures or to log changes to existing procedures. 

4.   From the Windows Control Panel >Administrative Tools, Run 
Services and make the start up option of the service named Distributed 
Transaction Coordinator is Automatic, and then start this service.

1.1.3 System Requirements

1.1.3.1 For Windows

• Windows NT 4.0 Server (with Service Pack 4 or Higher) or Windows 2000 
Server

1.1.3.2 For AIX

• AIX  V4.3.3 or higher, or AIX 5.1 or higher

1.1.3.3 For Solaris

• Solaris  8, maintenance level August 2001, or Solaris 9
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1.2 Web Client Requirements

1.2.1 Hardware Requirements
• Pentium III 650 MHz, or higher

• 128 MB RAM, or higher (256 MB recommended)

1.2.2 Software Requirements
• Java-enabled browser (preferably, IE 5.0 or higher)

• Java 2 Runtime Environment (JRE) 1.4.0 or higher. 

You can download and install it from the following URL:

http://java.sun.com/getjava/manual.html

To Enable Printing processes diagrams and other objects’ reports in BPM Web 
Publisher, you have to perform the following adjustments in your browser’s 
settings:

1.   Select Tools > Internet Options from the Microsoft Internet Explorer 
menu

2.   Select the Advanced tab.

3.   Navigate the Settings list to Java (Sun) section

4.   Clear the check box named Use java 2 v1.4.0_01 for <applet> 
(requires restart)

5.   Click OK and restart the browser.

6.   Select the Security tab.

7.   Select Local Intranet from the Select Web content zone to specify its 
security setting list.

8.   Click Custom Level. The Security Settings dialog box appears.

- Navigate the Settings list to Microsoft VM section.

- Select Custom radio button.

- Click Java Custom Setting. The Internet dialog box appears.

- Select the Edit Permissions tab.

*  Navigate the Permissions list to Unsigned Contents > Run 
Unsigned Content > Additional Unsigned Permissions > 
Printing.

*  Select the Enable Radio Button.

*  Navigate the Permissions list again to Signed Contents > Run 
Signed Content > Additional Signed Permissions > Printing.

*  Select the Enable Radio Button.
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9.   If You are accessing the WBI Workbench Server client from the Internet 
then Repeat steps 7 and 8 by selecting the Internet Web content zone.

10.   Restart the browser.

11.   For Windows 2000 clients make sure that you have installed Service 
Pack 3 in order to insure proper printing.

Important Note: Only PCL-type printers should be used in order to 
print BPM Web Publisher diagrams properly in all languages.

1.2.3 System Requirements
• Windows 98, Windows NT 4.0 (with Service Pack 3 or higher), Windows 

2000, or Windows XP 
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Chapter 2: Creating the WBI 
Workbench Server 
Database

After you have installed the WBI Workbench Server using the WBI Workbench 
Server Installation Wizard, you need to create and configure the WBI 
Workbench Server database, and create the database tables. This can be done 
through the InstallServer utility.

The InstallServer utility allows you to do the following:  

• Create and configure a new WBI Workbench Server database and 
database tables.

• Update the existing WBI Workbench Server database tables’ contents with 
the new database tables’ version.

• Define the WBI Workbench Server security System Manager.

The InstallServer utility should be installed on the same machine on which the 
Database Server is installed. If the Database Server and the IBM WebSphere 
Application Server are not installed on the same machine, then you can install 
the InstallServer utility again using the WBI Workbench Server Installation 
Wizard on the  machine on which the Database Server is installed.

Important Note: For IBM DB2 database on AIX and Solaris 
platforms, If you have multiple database instances, then the WBI 
Workbench Server database should be created in the same 
instance where the IBM WebSphere database (the WAS database) 
exists.

For Oracle database server, The WBI Workbench Server database should be 
created and configured manually providing that the default name of the 
database will be  BPRORA1 unless you change this name. In addition, you 
must create a user to be used for creating and configuring the database tables  
providing that its user name must be WFBPR. This user should have a 
database administrative (DBA) privilege on the created database instance.

The Install Server utility starts by running the batch file named Login.bat on 
Windows platform or the shell file named Login.sh  on AIX and Solaris 
platforms. These two files are located in <WBServerHomeDir>\installserver
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2.1 Adjusting the Required 
Parameters and Configuration

Before starting the Install Server utility you may need to do the following:

• If your database is installed in a different machine from the server on which 
the IBM WebSphere is installed, then you need to Copy these two files 
(xerces.jar and j2ee.jar) from the <WebSphere>\lib folder to 
<WBServerHomeDir>\installserver\lib folder. And then edit the login.bat 
(or login.sh) file in order to adjust the path of these two files.

• If your database is installed in the same machine on which the IBM 
WebSphere Application Server is installed, then you need to make sure 
that an environment variable named WAS_HOME is defined and contains 
the actual path of the IBM WebSphere installation directory. If this variable 
is not defined, then you must define it

• On AIX and Solaris platforms, If you are using IBM DB2 as the database 
server, make sure that you run the InstallServer Utility with a user who is in 
the DB2 Administrators group. You should also run at least once the 
<DB2>/db2profile file from the same terminal console from which you will 
start the InstallServer Utility. 

• You may need also to edit the Login.bat (or the Login.sh) file that runs the 
InstallServer utility in order to adjust the path of the database JDBC driver 
file according to the Database Server you are using. This is done 
automatically through the WBI Workbench Server installation wizard. 
However, in case you changed the path of the JDBC driver file you have 
chosen in the wizard steps, then you have to edit the Login.bat or the 
Login.sh files to adjust the actual path of this file.

• If the path of the java.exe in Windows platform (or java in AIX and Solaris 
platforms) is not defined in the Path environment variable, then you need 
also to edit the login.bat (or login.sh) file to adjust the path of the java.exe 
(or java) to include the full path on which it exists.

The following sections describe how to perform each of the above steps:

2.1.1 Adjusting the JDBC Driver Path
To adjust the JDBC Driver path:

This step is not required if the WBI Workbench Server Installation 
Wizard has recognized the path of the database JDBC Driver file 
successfully. 

1.   Open the Login.bat (or the Login.sh) for edit.

2.   Edit the classpath line to adjust the path of the JDBC driver file to reflect 
the actual path and name of this file.  
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3.   Save and close the Login.bat (or the Login.sh) file.

2.1.2 Adjusting the Extra Jar Files Path
To adjust the path of the xerces.jar and j2ee.jar files that you have copied from 
the machine on which the IBM WebSphere Application Server exists to the 
<WBServerHomeDir>\installserver\lib folder:

1.   Open the Login.bat (or the Login.sh) for edit.

2.   Put a Remark sign (#) before the second line that sets the path of the 
extra_jar variable equals %WAS_HOME%.

For AIX and Solaris platforms the EXTRA_JAR variable equals 
$WAS_HOME

3.   Remove the Remark sign from the beginning of the first line that sets the 
path of the extra_jar variable equals 
<WBServerHomeDir>\installserver\lib.

4.   Save and close the Login.bat (or the Login.sh) file.

2.1.3 Adjusting the Java Runtime Path
To adjust the path of the java.exe on Windows platform (or the java on AIX and 
Solaris platforms), 

1.   Open the Login.bat (or the Login.sh) for edit.

2.   Edit the classpath line to add the actual path of the java.exe or the java 
(the Java home directory) before it. 

Example:

If you are using the JDK that is shipped with the IBM WebSphere 
Application Server, then you should adjust the classpath line to start 
with <WebSphere>\java\bin\java.exe in Windows platform or 
<WebSphere>/java/bin/java in AIX and Solaris platforms.

3.   Save and close the Login.bat (or the Login.sh) file.

2.1.4 Adjusting the WAS_HOME Environment 
Variable

To define the WAS_HOME environment variable if it was not defined, you can 
perform one of the following three methods:

The first method applies only to Windows platform. The first method’s steps are:

1.   Click the Start button on the Windows taskbar.

2.   Select Settings > Control Panel.
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3.   Double-click the System icon

4.   The System Properties dialog box appears.

5.   Select the Advanced tab.

6.   Click the Environment Variables button.

The Environment Variables dialog box appears.

7.   In the System Variables section, scroll the variables list and look for a 
previously defined variable with the name WAS_HOME. If this variable 
has been already defined and contains the correct path of the IBM 
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WebSphere installation directory, then you can exit the dialog box and 
start the Automatic Deployment wizard. If the variable does not exist, 
then click New. The New System Variable dialog box appears.

8.   In the Variable Name field, type WAS_HOME

9.   In the Variable Value field, type the installation directory of the IBM 
WebSphere.

10.   Click OK to close the New System Variable dialog box.

11.   Click OK to close the Environment Variables dialog box.

12.   Click OK to close the System Properties dialog box.

The second method applies to Windows, AIX and Solaris platforms. The second 
method’s steps are:

1.   In Windows platform:

- Open a command line window.

- Type the following:

Set WAS_HOME = <WebSphere> 

(Where <WebSphere> is the IBM WebSphere installation 
directory. e.g. C:\WebSphere\AppServer).

- Run the Login.bat from this command line window.

2.   In AIX and Solaris platforms:

- Open a command line window.

- Type the following in the command line:

WAS_HOME= <WebSphere> 

export WAS_HOME 

(Where <WebSphere> is the IBM WebSphere installation 
directory. e.g. /usr/WebSphere/AppServer in AIX, or /opt/
WebSphere/AppServer in Solaris)..

- Run the Login.sh from this command line window.

The third method applies to Windows, AIX and Solaris platforms. The third 
method’s steps are:

1.   Open the Login.bat (or the Login.sh) for edit.

2.   Type the following in a new line before the first line:
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- In Windows platform:

Set WAS_HOME = <WebSphere> 

(Where <WebSphere> is the IBM WebSphere installation 
directory).

- In AIX and Solaris platforms:

WAS_HOME= <WebSphere> 

export WAS_HOME 

(Where <WebSphere> is the IBM WebSphere installation directory. 
e.g. /usr/WebSphere/AppServer in AIX, or /opt/WebSphere/
AppServer in Solaris).

3.   Save and close the Login.bat (or the Login.sh) file.

2.1.5 Running the db2profile Command
In order to run the db2profile command:

This section’s steps applies only if you are using IBM DB2 as the 
database server on AIX and Solaris platforms,,

1.   Open a terminal console.

2.   Change the directory to <DB2>.

3.   Type the following in the command line and then press Enter:

. ./db2profile

4.   Run the Login.sh file from the same terminal console.
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2.2 Opening the Install Server Utility
After selecting and adjusting the proper variables and configurations, then you 
can now start the InstallServer utility.

1.   Start the Install Server utility by running the Login.bat on Windows 
platform or the Login.sh on AIX and Solaris platforms.

The Login window appears. 

2.   Enter the user ID and password of the Database administrator that were 
defined during the WBI Workbench Server Installation wizard. This user 
must be a Database Administrator.

• These Fields are case sensitive.

• If you are using Oracle Database Server, then the User ID of 
the database administrator will be WFBPR and it cannot be 
modified. This user should be created manually with 
Database Administrative privileges on the WBI Workbench 
Server database instance that you have created manually 
before starting the InstallServer Utility.

3.   Click OK.

- If the user ID or password is incorrect, then a message will appear to 
notify you of the incorrect login data. Click OK on the message to 
return to the Login window in order to enter the correct information.  
© Copyright IBM Corp. 2002, 2003                                          17



- If the entered user ID or password is correct, then then the Install 
Server utility will start and the Install Server’s main window will appear. 
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2.3 Creating and Configuring a New 
Database

The following steps are performed when you create the WBI Workbench Server 
database for the first time. 

2.3.1 Creating and Configuring the Database Using 
the InstallServer Utility

The InstallServer Utility allows you to create the WBI Workbench Server 
database automatically. In this case, the database will be created with a default 
name BPR and default code page UTF-8. In addition, a BufferPool will be 
created with a default name BPRPool and a default page size 8K. Moreover, a 
default TableSpace will be created using this BufferPool with a default name 
BPRTableSpace. The database tables will be created using this TableSpace.

If you want to create the database with a different name and/or different code 
page, then you should create and configure the database manually. 

For Oracle database server, the Create Database and Configure 
Database commands will be disabled. The Database Administrator 
should create and configure the WBI Workbench Server database 
manually, providing that the default name of the database will be  
BPRORA1, unless the administrator changes this name.

To create and configure a new Workbench Server database from scratch, if it is 
the first time you deploy the WBI Workbench Server:

Important Note: These steps will drop any old database, and any 
existing data will be lost.

1.   Create the new WBI Workbench Server database by selecting Database 
> Create Database from the menu, or by clicking the Create Database 
button in the Install Server main window.

2.   Configure the database by selecting Database > Configure Database 
from the menu, or by clicking the Configure Database button in the 
Install Server main window.

- If you are using IBM DB2, the Configure Database command does 
the following:

*  Sets the database configuration parameters (such as Application 
Control Heap Size, Application Heap Size, Log File Size, Log 
Buffer Size, Database Heap, Lock List, and Statement Heap) with 
values that enhance its performance.
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*  Grants the user who will create the database with the needed 
privileges.

-  If you are using MS SQL Server, the Configure Database command 
does the following:

*  Creates a user named WFBPR. The database tables will be 
created on the schema of this user.

*  Grants this user with the needed privileges.

2.3.2 Creating and Configuring the Database 
Manually

If you want to create the database with a different name from the default name 
(BPR), then you should create and configure the database manually. 

In order to allow the created database to support multiple languages, the  
database should be created with the UTF-8 codepage. 

2.3.2.1 For Oracle Database: 

1.   Create the WBI Workbench Server database either with the default 
name BPRORA1 or with any other name.

2.   Create a user named WFBPR with a Database Administrative privileges 
(DBA) on the created Database Instance.

3.   You can configure the created database with the appropriate values that 
are suitable for your settings.

2.3.2.2 For MS SQL Server Database

1.   Create the WBI Workbench Server database either with the default 
name BPR or with any other name.

2.   Create a user named WFBPR to be used for creating the database 
tables on his/her schema.

3.   You can configure the created database with the default values.

2.3.2.3 For IBM DB2 Database 

1.   Create the WBI Workbench Server database either with the default 
name BPR or with any other name.

2.   You must configure the database with the following values:

- application control heap size =64000

- application heap size =8192

- log file size = 8192

- log buffer size =128

- database heap = 1024
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- lock list = 1000

- statement heap = 8192 

2.3.3 Creating the Database Tables
After creating and configuring the database, you need to create the database 
tables. This is done by selecting Database > New Installation from the menu, 
or by clicking the New Installation button in the Install Server utility main 
window. 

If you have created the database manually with a name other than the default 
names, then you should edit the file named database.properties located in the 
<WBServerHomeDir>\installserver folder, in order to change the default name 
with the name you have used for creating the database. This should be done 
before starting the InstallServer Utility. To do this:

1.   Open the database.properties file for edit with any text editor.

2.   Edit the sourceUrl value to change the following values, if needed:

- For IBM DB2, change the database default name (BPR) with the new 
name you have used for creating the database manually.

- For MS SQL Server:

*  Change the Database Server machine IP address and Port 
Number with the correct IP Address and Port Number of the 
Database Server machine. This is done if you have created and 
configured the database manually on a different Database Server 
machine.

*  Change the database default name (BPR) with the new name you 
have used for creating the database manually.

- For Oracle Database:

*  Change the Database Server machine IP address and Port 
Number with the correct IP Address and Port Number of the 
Database Server machine. This is done if you have created and 
configured the database manually on a different Database Server 
machine.

*  Change the database default name (BPRORA1) with the new 
name you have used for creating the database manually.

3.   To configure the database TableSpace, edit the line that contains the 
TableSpace name to contain the new TableSpace name:

TableSpace = <TableSpaceName>. 

Where <TableSpaceName> is the TableSpace name.

- For IBM DB2, if the database has been created with the UTF-8 code 
page, then the TableSpace should be created with a BufferPool that 
has a page size 8K.
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4.   If the code page of the created database is not UTF-8, add a new line 
that contains the following:

UTF8 = False

5.   Save and close the file.
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2.4 Updating an Existing Database 
with a New Version

If you already have the previous version  of WBI Workbench Server (v4.2.2 and 
higher) and you  obtained the recent version (v4.2.4 Fix Pack1 with HotFix) that 
includes changes in the database structure, then you will need to update your 
exisiting database settings. By updating database settings, you avoid creating a 
new database that will drop the old database with all its stored data.

In addition, you should select the appropriate code page for each organization 
that is stored in the database you are upgrading. The selected code page will 
identify to the Web browser the proper settings and fonts that should be used in 
order to display the information of this organization. The supported codepages 
are:

• Switching GUI and text direction to Right-to-Left is not supported 
in this release.

• Important Note: If the existing database of the previous version 
has a different name other than the default name, then you should 
edit the file named database.properties located in the 
<WBServerHomeDir>\installserver folder, in order to change the 
default name with the name you have used for creating the 
database. This should be done before starting the InstallServer 
Utility and using it for upgrading the database tables. Refer to the 
steps for editing the database.properties file that are mentioned in 
the section entitled Creating the Database Tables for details about 
how to do this.

In order to update the database with the new database configuration: 

1.   Select Database > Update Version from the Install Server utility menu 
bar, or click the Update Version button in the Install Server utility main 
window. The CodePage Upgrade window appears. This window lists all 
existing organizations that are stored in the database you are upgrading.

If the database you are upgrading has no stored organization in it, 
then the CodePage Upgrade window will not appear, and the 
database updating process will start directly.

1252 - English 1255 - Hebrew

1252 - French 1256 - Arabic

1252 - German 932 - Japanese

1252 - Italian 936 - Chinese (Traditional)

1252 - Portuguese 950 - Simplified Chinese

1252 - Spanish 949 - Korean
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2.    For each listed organization in the organizations table, select the 
appropriate codepage for the organization from the Codepage drop-
down list in each organization row.

3.   Click OK. The application will start updating the database with the new 
table structure without deleting the old data, and updating the existing 
organization with the selected codepages.  

Important Note: If you are upgrading a database of version 4.2.2 
then the stored organizations will be upgraded to version 4.2.3 
only. You will need to perform the organization upgrade through 
the Administrative page in the BPM Repository in order to upgrade 
these organizations to version 4.2.4 Fix Pack1 HotFix.

Important Note: If you close the CodePage Upgrade window, 
instead of clicking OK, without setting the organizations’ 
codepages, then the codepage 1252 - English will be set by default 
for all organizations, even if any of the existing organization has a 
previously defined codepage.

After updating the database with the new version, all stored organization in the 
database will be upgraded to the new version.

The WBI Workbench Server (v4.2.4 Fix Pack1 HotFix) database holds 
organization files that are created with IBM WebSphere Business Integration 
(WBI) Workbench™ versions 4.2.3,  4.2.4, 4.2.4 Fix Pack1, and 4.2.4 Fix Pack1 
HotFix. The BPM Repository supports adding organization files created by 
these WBI Workbench versions only. Organization files that were created by an 
earlier WBI Workbench version (v4.2.2 and earlier) should be converted first – 
using WBI Workbench version 4.2.3,  4.2.4, 4.2.4 Fix Pack1, or 4.2.4 Fix Pack1 
HotFix - to one of these versions before adding them to the WBI Workbench 
Server database. Refer to the WBI Workbench Server User Guide for more 
information about adding organizations to the database.

If you are upgrading an existing database of version 4.2.2 to 
version 4.2.4 Fix Pack1 HotFix,  then you should make sure that 
the database TableSpace you are using is named BPRTableSpace 
and that this TableSpace exists. If you are using a diifernt 
TableSpace then you must edit the file named database.properties 
to change the TableSpace name in the line that contains the 
TableSpace name to contain the new TableSpace name before 
clicking the Update Version button. A message will appear to 
inform you with that upon clicking the Update Version button.
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The database migration to WBI Workbench Server 4.2.4 Fix Pack1 
HotFix can be done only if the existing database belongs to these  
versions of WBI Workbench Server (v4.2.2, v4.2.3,  v4.2.4, and 
v4.2.4 Fix Pack1). If the existing database belongs to an earlier 
version than v4.2.2 (version 4.2.1 and before), then you cannot 
migrate the database directly to the current version. In this case 
you must upgrade your existing database incrementally to version 
4.2.2, by using the InstallServer Utility of this version to keep the 
history of the  added processes versions. Afterwards, you can 
upgrade the database to the recent version of WBI Workbench 
Server.

In order to allow the WBI Workbench Server v4.2.4 database to support multiple 
languages data, it should have been created using UTF-8 code page. 
Otherwise, you should migrate the existing database manually using your 
database options to a new database that is created using UTF-8 code page. 
Refer to your database server documentation for more information about the 
database migration/export option.
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2.5 Creating the WBI Workbench 
Server Security System Manager

To create the WBI Workbench Server security system manager:

1.   If you have selected LDAP as your security type:Select Database 
Security Manager > Create Security Manager. 

The LDAP Configuration dialog box appears.

- Type the LDAP Server port name in the LdapPort box. (eg. ldap://
Ldapsrvr:389/)

- Type the LDAP distinguished name (DN) for the user who will be 
defined as the security system manager in the Name box. 

- Type the user’s password in the Password box and click OK.  

- The entered information of the specified user is saved to the database.

2.   If you have selected Local as your security type

- Select Database Security Manager > Create Security Manager. 

The Local Configuration dialog box appears.

The Name and Password fields display the user name and 
password of the security system manager. You cannot edit these 
two fields.
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You cannot change the user who is defined as the security system 
manager from this dialog box. In order to change the security 
system manager, you must re-install the Install Server utility and 
define a new user through the installation steps.

- Click OK.  

3.   Exit the Install Server utility by selecting File > Exit from the menu.
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Chapter 3: WBI Workbench Server 
Application Server 
Deployment

After the WBI Workbench Server database has been created and configured 
and the database tables have been created, you are now ready to deploy the 
WBI Workbench Server application server on IBM WebSphere. The deployment 
can be done either manually through the IBM WebSphere Administrator's 
Console, or automatically using the automated deployment wizard that is 
installed in the WBI Workbench Server Home directory through the WBI 
Workbench Server installation wizard.

The instructions in the following sections describe the automated methods of 
the WBI Workbench Server deployment on IBM WebSphere Application Server 
4.0.2,  IBM WebSphere Application Server 5.0 and IBM WebSphere 
Deployment Manager 5.0 (for Network Deployment). For a description of the 
manual deployment on WebSphere Application Server 4.0.2, please refer to 
Appendix A of this guide: Manual Deployment of WBI Workbench Server on 
WebSphere Application Server 4.0.2. For a description of the manual 
deployment on IBM WebSphere Application Server 5.0 and IBM WebSphere 
Deployment Manager 5.0, please refer to Appendix B of this guide: Manual 
Deployment of WBI Workbench Server on IBM WebSphere Application Server 
5.0 and IBM WebSphere Deployment Manager 5.0.
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3.1 Automated Deployment of WBI 
Workbench Server Application 
Server on WebSphere

The following sections describe how to deploy and start the WBI Workbench 
Server application server on IBM WebSphere Application Server automatically 
using the WBI Workbench Server Automatic Deployment wizard. This wizard 
can be run on Windows, AIX and Solaris platforms. For Windows platform, you 
need to run the file named setup.bat  For AIX and Solaris platforms you need to 
run the file named setup.sh. These two files are located in the 
<WBServerHomeDir>\was4-wizard folder for IBM WebSphere Application 
Server 4.0.2 or in <WBServerHomeDir>\was5-wizard for IBM WebSphere 
Application Server 5.0 and IBM WebSphere Deployment Manager 5.0 that was 
copied to your hard drive after running the WBI Workbench Server installation 
wizard.

3.1.1 Edit the System Properties Environment 
Variables

Before starting the Automatic Deployment wizard, you have to make sure that 
an environment variable named WAS_HOME is defined and contains the actual 
path of the IBM WebSphere installation directory. Refer to the section entitled 
Adjusting the WAS_HOME Environment Variable above in this document for 
the detailed steps of defining this variable, providing that you should apply the 
steps of this section on the setup.bat (or setup.sh) file instead of the Login.bat 
(or Login.sh) file.

On AIX and Solaris platforms, if you are using IBM DB2 as the database server, 
you should also run, at least once, the <DB2>/db2profile file from the same 
terminal console from which you will start the setup.sh file. Refer to the section 
entitled Running the db2profile Command above in this document for the 
detailed steps of running this command, providing that you should apply the 
steps of this section on the setup.sh file instead of the Login.sh file.

3.1.2 Run the Deployment Wizard
The following steps describe how to deploy the WBI Workbench Server 
Application Server and its Web Application automatically using the WBI 
Workbench Server deployment wizard.

After configuring the required environment variables and the WBI Workbench 
Server parameters, then you can start the WBI Workbench Server Automatic 
Deployment wizard:

1.   Run the file named setup.bat on Windows platform (or setup.sh on AIX 
and Solaris platforms). The WBI Workbench Server Deployment Wizard 
will start on the Welcome screen. The left-hand map will display all the 
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deployment steps, the step that is currently running, the completed 
steps, and the remaining steps. In all coming steps, to go forward to the 
next step, click Next. To go back to the previous step click Previous. 
You can exit the deployment wizard at any time by clicking Cancel. 

2.   The next screen is the Install Steps where you will be notified with the 
following deployment steps and their purpose. The deployment steps 
will perform these two main tasks:

- Verifying and checking the existence of the pre-requisite software 
products, the installed version, the installation location, and the 
installed components of each product.

- Deploying the WBI Workbench Server component and performing all 
necessary operations to finalize WBI Workbench Server deployment 
properly.
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Click Next to continue. 

3.   In the next screen you will be informed with the software requirements 
that the wizard will check. Click Next to continue.

4.   In the next screen you will be asked to enter the Database JDBC driver  
file path and the Database type. 

- For IBM DB2 this driver file is named db2java.zip and located in the 
<DB2>\java12 folder
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- For Oracle this driver file named classes12.zip and located in the 
<ORACLE_HOME>\jdbc\lib folder

- For MS SQL Server this driver file named mssqlserver.jar and  
located under the lib folder inside the SQL Server JDBC Driver 
installation folder. You have to make sure that the files named  
msutil.jar and msbase.jar exist in the same folder.

Enter the required path or click Browse to select the path. 

From the Database Type combo box, select the Database type (DB2, 
Oracle or MS SQL Server)

If the entered path or name is not correct, then you will be informed by a 
message, and the wizard will not continue until you enter the correct 
path. Then, you can click Next to continue.
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5.   In the next screen, you will be asked to enter following IBM WebSphere 
parameters:

- If you are using IBM WebSphere Application Server v4.0.2 then you 
need only to enter the location of the AppServer folder that is located 
in the WebSphere installation folder. (i.e. C:\WebSphere\AppServer) 

Enter the required path or click Browse to select the path. If the 
entered path is not correct, then you will be informed by a message, 
and the wizard will not continue until you enter the correct path.

- If you are using IBM WebSphere Application Server v5.0 or IBM 
WebSphere Deployment Manager (Network Deployment) v5.0, enter 
the following parameters:

*  In the WebSphere Home field, enter the installation path of IBM 
WebSphere 

- For IBM WebSphere Application Server v5.0, enter the location 
of the AppServer folder that is located in the 
WebSphere installation folder. (i.e. C:\WebSphere\AppServer)

- For IBM WebSphere Deployment Manager (Network 
Deployment) v5.0, enter the location of the 
DeploymentManager folder that is located in the 
WebSphere installation folder. (i.e. 
C:\WebSphere\DeploymentManager) 

Enter the required path or click Browse to select the path. If 
the entered path is not correct, then you will be informed by 
a message, and the wizard will not continue until you enter 
the correct path.

*  In the Node Name field, enter the node name on which you will 
deploy the WBI Workbench Server. The wizard will check if you 
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entered a node name or not in this step and it will not continue 
until you enter a node name. The actual existence and the validity 
of the entered node name will not be checked in this step. It will be 
checked when the wizard start the deployment or when you run 
the deployment script if you chose to generate only the 
deployment script and run it later..

*  Select the Deploy in Working Directory check box if you want to 
deploy the WBI Workbench Server Enterprise Application in the 
WBI Workbench Server working directory that will be entered later 
in a coming step. Leaving this check box cleared will set the 
deployment directory the default directory that the IBM 
WebSphere uses for deployment. (i.e. 
C:\WebSphere\AppServer\installedApps)

*  Select the Create new application server check box to create a 
new application server named BPRAppServer on which the WBI 
Workbench Server Enterprise Application will be deployed. If you 
keep this check box cleared then the WBI Workbench Server 
Enterprise Application will be deployed on the Base Server named 
server1. It is preferred to select this check box in case you are 
deploying on WebSphere Deployment Manager (Network 
Deployment) v5.0.

Click Next to continue.

6.   Now the information required about the pre-requisite software has been 
entered. The next step will inform you that the wizard will start deploying 
the WBI Workbench Server which includes the following:

- Gathering the required information for WBI Workbench Server.

- Generating the deployment script.
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- Performing the WBI Workbench Server deployment procedure by 
using the generated script.

Click Next to continue.

7.   In the next step you should enter the WBI Workbench Server installation 
directory which will be used as the Working Directory. On AIX and 
Solaris platforms you should have a write access on this folder in order 
to allow the wizard to copy the necessary folders and files to this folder.

Also you can select the Version Reminder check box in order to allow 
displaying a message in the BPM Repository that reminds you to create 
a new version for the processes before you check them out, or you can 
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clear this check box to disable displaying this message. Click Next to 
continue.

8.   In the next screen you will be informed with the required parameters that 
you should enter for the WBI Workbench Server Database. Click Next to 
continue.

9.   In the next step, you should enter the following parameters for the WBI 
Workbench Server database:
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- In the Workbench Connection Option section, select the connection 
type between the Workbench Server application server and the 
Database Server from the Connection Type drop down list:

*  Select Local Connection for the direct connection between the 
Workbench Server application server and the Database Server.

*  Select DataSource to allow the connection between the 
Workbench Server application server and the Database Server 
through a DataSource.

- In the Workbench Server Database section, enter the WBI 
Workbench Server database name or URL, and the user name and 
password of the WBI Workbench Server database administrator in the 
corresponding fields:  

*  For IBM DB2:

- Database Name: BPR

*  For MS SQL Server:

- Database URL:  jdbc:microsoft:sqlserver://
<SQL_Server_Machine_Name>:<SQL_Server_Port_Number>;Da
tabaseName=BPR

Where <SQL_Server_Machine_Name> is the machine 
name of the machine on which the MS SQL Server is 
installed, and <SQL_Server_Port_Number> is the MS 
SQL Server Port Number. (E.g. 
jdbc:microsoft:sqlserver://SQLMachine:1433;Database-
Name=BPR)

*  For Oracle:

- Database Name: BPRORA1

- DB Admin:  Type WFBPR

- If your database server is Oracle or MS SQL Server, then enter the 
following information in the For SqlServer and Oracle Database 
Types section:

*  In the DB Server/IP field, enter the name or the IP address of the 
Database Server machine.

*  In the Port Number field, enter the Database Server machine’s 
port number.

The wizard will check the connection with the database with the entered 
user name and password. If one or more of the entered parameters are 
not correct, then you will be informed by a message, and the wizard will 
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not continue until you enter the correct parameters. Then, you can click 
Next to continue.

10.   In the next step, select the security mode you want to apply (Local 
Security or LDAP Security) from the Security Mode combo box. Then 
click Next to continue.

11.   In the next step, if you select the LDAP Security mode then enter the 
following parameters in the For LDAP Security Only section:
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*  In the LDAP URL field: Type the LDAP Server name and port 
number (e.g. ldap://ldapsrvr:389/) 

On AIX and Solaris platforms, type the LDAP server IP address 
instead of the server name  

*  The remaining parameters are needed to allow logging in to WBI 
Workbench Server client using only the User ID, instead of having 
to supply the full Distinguished Name (DN). If you leave these 
parameters empty, then the user will not be able to login.

When the user tries to log in to the WBI Workbench Server 
client using only his/her user ID, the application queries the 
LDAP Server for the full DN of this user using the following 
parameters, and then uses the obtained full DN for login. 

The required parameters are:

- In the User DN field: Type a Distinguished Name (DN) for an 
LDAP Server authorized user that will be used for logging in to 
this LDAP Server, and performing the search in the LDAP 
users tree.

- In the User Password field: Type the password of the defined 
User DN.

The User DN and User Password fields are optional. If you leave 
these fields empty without specifying a user then the user 
Anonymous will be used. In this case this user should have at 
least read/search access rights on the LDAP directory.

- In the Naming Attribute field: Type the name of the prefix that 
preceds the user ID in the LDAP Server database (i.e. CN, 
UID,...etc). The value of this parameter varies between the 
different types of LDAP Servers.

- In the Base of Search field: Type the starting point in the LDAP 
tree from which the query will start searching for the full DN of 
the given user ID.

- In the DN Attribute ID field: Type the name of the 
Distinguished Name attribute ID (i.e. distinguishedName, 
entrydn, ...etc. This value is case sensitive).
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Click Next to continue

12.   After gathering the required information about the WBI Workbench 
Server deployment, the wizard now is ready to start deploying WBI 
Workbench Server. The wizard will first create the deployment script, 
and then this script will be used to deploy WBI Workbench Server. You 
can only create the deployment script, and then you can run this script 
later. The created script will be placed in <WBServerWorkDir>\install. 
To deploy WBI Workbench Server by using this script, run the batch file 
named BPRServerInstall.bat (or bprserverinstall.sh for AIX and Solaris 
platforms) in the previous path.

- To generate the deployment script and deploy WBI Workbench Server, 
select the Deploy check box.

- To generate the script only, clear the Deploy check box.
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Now click Next to continue.

13.   Now the WBI Workbench Server deployment has finished. You will 
need to start the deployed Application Server from the WebSphere 
Administrator’s Console, in order to run WBI Workbench Server. Click 
Finish to exit this Deployment Wizard.

Important:

If the message that says:
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"WASX7023E: Error creating "SOAP" connection to host "localhost"; exception 
information: 
com.ibm.websphere.management.exception.ConnectorNotAvailableException 
WASX7213I: This scripting client is not connected to a server process; please 
refer to the log file C:\Program 
Files\WebSphere\DeploymentManager\logs\wsadmin.traceout for additional 
information." appears when the wizard starts the deployment and the 
deployment didn’t start, then you must edit the batch filesnamed: 
BPRServerInstall.bat, and the BPRServerUninstall.bat files (or the 
BPRServerInstall.sh and BPRServerUninstall.sh) that have been generated by 
the wizard in the <Working Directory>\Install folder, and also the batch files 
named startBPRAppServer.bat and stopBPRAppServer.bat (or 
startBPRAppServer.sh and stopBPRAppServer.sh) that are generated in the 
<Working Directory> folder. To do this:

1.   Obtain the port number of the SOAP_CONNECTOR_ADDRESS for the 
Base Server (server1) in case you are using IBM WebSphere 
Application Server 5.0 or for the Deployment Manager in case you are 
using IBM WebSphere Deployment Manager (Network Deployment) 5.0. 
To do this:

- For the IBM WebSphere Application Server 5.0:

*  Open the IBM WebSphere Administrative Console

*  From the left hand tree, select Servers > Application Servers

*  Click the server1 hyperlink in the servers list

*  From the server1 configuration page, click the End Points 
hyperlink in the Additional Properties table.

*  Click the SOAP CONNECTOR ADDRESS hyperlink from the End 
Point Name column.

*  Use the value that exists in the Port field.

- For the IBM WebSphere Deployment Manager (Network Deployment)  
5.0:

*  Open the IBM WebSphere Administrative Console

*  From the left hand tree, select System Administration > 
Deployment Manager

*  From the Deployment Manager configuration page, click the End 
Points hyperlink in the Additional Properties table.

*  Click the SOAP CONNECTOR ADDRESS hyperlink from the End 
Point Name column.

*  Use the value that exists in the Port field.

2.   Edit the BPRServerInstall.bat, BPRServerUninstall.bat, 
startBPRAppServer.bat, and stopBPRAppServer.bat files (or the 
bprserverinstall.sh bprserveruninstall.sh, startBPRAppServer.sh and 
stopBPRAppServer.sh).
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3.   Add the following section to the command written in these batch (or 
shell) files after the wasadmin path:

-conntype SOAP -port <the obtained port number>

Examples: 

• In the BPRServerInstall.bat the line should be:

call “C:\WebSphere\DeploymentManager\bin\wsadmin.bat” –conntype SOAP 
–port 8889 –wsadmin_classpath “../lib/wizardValidate.jar;../lib/jdom.jar” –f 
InstallBPRServer.jacl

• In the BPRServerUninstall.bat the line should be:

call “C:\WebSphere\DeploymentManager\bin\wsadmin.bat” –conntype SOAP 
–port –f InstallBPRServer.jacl

• In the startBPRAppServer.bat the line should be:

call "C:\IBM\WebSphere\DeploymentManager\bin\wsadmin.bat"-conntype 
SOAP -port 8889 -c "$AdminControl startServer BPRAppServer Node1"

• In the stopBPRAppServer.bat the line should be:

call "C:\IBM\WebSphere\DeploymentManager\bin\wsadmin.bat"-conntype 
SOAP -port 8889 -c "$AdminControl stopServer BPRAppServer Node1"

Where 8889 is the obtained port number for the SOAP CONNECTOR 
ADDRESS

3.1.3 Start the New Application Server
After the deployment has finished, you have to start the new Application you 
have created. This is done through the WebSphere Administrator's Console. To 
do this:

3.1.3.1 For IBM WebSphere Application Server v4.0.2

1.   Start the WebSphere Administrator’s Console.

2.   In the WebSphere Administrative Domain tree, right-click Nodes > 
<ServerName> > Application Server > BPRAppServer and select 
Start from the shortcut menu that appears.
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3.   Wait until the confirmation message appears, and then click OK.

3.1.3.2 For IBM WebSphere Application Server v5.0

If you deployed the WBI Workbench Server Enterprise application on the Base 
Server named server1, then you must restart this base server (server1). To do 
this: 

1.   IN Windows platform, run a command prompt window. In AIX or Solaris 
platforms start a console window.

2.   Change the directory to <WebSphere>\bin

3.   Type the following command line:

stopServer server1

For AIX and Solaris platforms, type stopServer.sh server1. This 
command is case sensitive.

4.   Wait until the Application Server is start and the confirmation message 
appears, and then type the following command line:

startServer server1

For AIX and Solaris platforms, type startServer.sh server1. This 
command is case sensitive.

5.   Wait until the Application Server is start and the confirmation message 
appears.

If you deployed the WBI Workbench Server Enterprise application on a new 
Application Server named BPRAppServer, then you must start this server. You 
can do this by two methods: 

The first method’s steps are:

1.   IN Windows platform, run a command prompt window. In AIX or Solaris 
platforms start a console window.
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2.   Change the directory to <WebSphere>\bin

3.   Type the following command line:

startServer BPRAppServer

For AIX and Solaris platforms, type startServer.sh BPRAppServer. 
This command is case sensitive.

4.   Wait until the Application Server is start and the confirmation message 
appears.

The second method’s steps can be done automatically by running the batch file 
named startBPRAppServer.bat in Windows platform (or the shell file named 
startBPRAppServer.sh in AIX and Solaris platforms) that is located in the 
<Working Directory>. To do this

1.   Run the batch file named startBPRAppServer.bat in Windows platform 
(or the shell file named startBPRAppServer.sh in AIX and Solaris 
platforms). 

2.   Wait until the Application Server is start and the confirmation message 
appears.

You can also use the batch file named stopBPRAppServer.bat (or 
stopBPRAppServer.sh) to stop this new Application Server

For IBM WebSphere Deployment Manager (Network 
Deployment) v5.0

In case you created a new Application Server, then start this Application Server. 
To do this

From the WebSphere Administrative Console, do the following:

1.   From the left hand tree, select Servers > Application Server. The 
Application Servers page appears.

2.   Select the BPRAppServer Application Server by selecting the check 
box next to the Application Server’s name.

3.   Click Start. 

You can use the batch files named startBPRAppServer.bat  and 
stopBPRAppServer.bat (or startBPRAppServer.sh  and 
stopBPRAppServer.sh) to start and stop this new Application 
Server
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3.2 Configure the Database 
Connection

If you are using IBM DB2 as your Database Server, and you have the Web 
Application Server on which you will deploy the WBI Workbench Server and the 
Database Server installed on separate machines, then you need to configure 
the connection between these servers to let the WBI Workbench Server 
Application Server deployed on WebSphere connect to its database on the 
Database Server. 

This is simply done by runningthe file named ClientConfig.bat on Windows 
platform or the file named ClientConfig.sh on AIX and Solaris platforms. These 
files are located in the <WBServerHomeDir>\was4-wizard\dbclientconfig folder 
for IBM WebSphere Application Server 4.0.2 or in <WBServerHomeDir>\was5-
wizarddbclientconfig folder for IBM WebSphere Application Server 5.0.

When you run this batch file, the Client Configuration window appears:

1.   Type the WBI Workbench Server database node name in the Node field.

2.   The Database Alias displays the default WBI Workbench Server 
database Alias which is “BPR” 

3.   Type the name or the IP address of the Database Server machine in the 
IP field.

4.   Type the port number or service name of the BPR database in the Port / 
Service field.

5.   Type the WBI Workbench Server database name in the Database 
Name field.

6.   Click OK to execute the configuration. 

7.   Click Close to close the window.
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3.3 WBI Workbench Server 
Application Server Un-deployment 

This section is used to completely un-deploy the WBI Workbench Server. To 
completely un-deploy the WBI Workbench Server perform the following steps:

1.   Stop the created WBI Workbench Server Application Server 
(BPRAppServer). 

2.   Run the batch file named BPRServerUninstall.bat in Windows platform 
or the file named bprserveruninstall.sh in AIX or Solaris platforms that 
are located in the <WBServerWorkDir>\Install folder. This batch file (or 
shell file) will uninstall WBI Workbench Server automatically. 

3.   Delete all files in the <WBServerWorkDir>folder. 
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3.4 WBI Workbench Server 
Uninstallation 

This section describes how to completely uninstall the WBI Workbench Server 
from your machine using the WBI Workbench Server Uninstallation Wizard in 
order to remove all folders and files that was installed by the WBI Workbench 
Server installation wizard. The WBI Workbench Server Uninstallation Wizard 
starts by running the jar file named uninstall.jar that is located in the  
<WBServerHomeDir>\_uninst folder.

Before starting the WBI Workbench Server Uninstallation Wizard, make sure 
that the IBM jdk 1.3.0 is installed on your machine.  Alternatively, you can use 
the IBM JDK shipped with IBM WebSphere Application Server. 

To start the WBI Workbench Server Uninstallation Wizard: 

1.   Run the uninstall.jar file by doing the following:

- In Windows platform: 

*  Start a command prompt window.

*  Type the following in the command prompt and then press Enter:

java.exe -jar <WBServerHomeDir>\_uninst\uninstall.jar 

If the java.exe is not your enironment variable path then type the 
full path of  java.exe (e.g. 
C:\WebSphere\AppServer\java\bin\java.exe)

- In AIX and Solaris platforms:

*  Start a terminal console using root.

*  Type the following in the command prompt and then press Enter:

 java -jar <WBServerHomeDir>/_uninst/uninstall.jar 

If the java is not your enironment variable path then type the full 
path of  java (e.g. “/usr/WebSphere/AppServer/java/bin/java” in 
AIX platform or “/opt/WebSphere/AppServer/java/bin/java” in 
Solaris platform  

2.   Once you start the Uninstallation wizard, a Welcome dialog box 
appears. Click Next to continue through the wizard or click Cancel to 
exit the wizard. 

3.   The next screen contains the Home Directory on which the WBI 
Workbench Server was installed and the installed components that will 
be removed. Verify that these settings are correct, and then click Next to 
start removing the files and folders from your hard drive, Back to return 
to the previous step, or Cancel to exit the wizard. 
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4.   After all files and folders are removed from your hard drive, the next 
screen will tell you that the Uninstallation Wizard has finished 
uninstalling the WBI Workbench Server from your system. Click Finish 
to exit the wizard. 
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3.5 Upgrading your Existing Version 
of WBI Workbench Server to the 
Recent Version

This section contains the required information about upgrading your existing 
version of WBI Workbench Server to the recent version. This includes 
upgrading the deployed version of WBI Workbench Server application on 
WebSphere Application Server, as well as upgrading the existing WBI 
Workbench Server database that already contains data stored in its tables to 
adhere to the latest modification in the current version of WBI Workbench 
Server 4.2.4 Fix Pack1 HotFix database, and migrate the stored data to the 
upgraded database. 

The WBI Workbench Server (v4.2.4 Fix Pack1 HotFix) database holds 
organization files that are created with IBM WebSphere Business Integration 
(WBI) Workbench™ versions 4.2.3,  4.2.4, 4.2.4 Fix Pack1, and 4.2.4 Fix Pack1 
HotFix. The BPM Repository supports adding organization files created by 
these WBI Workbench versions only. Organization files that were created by an 
earlier WBI Workbench version (v4.2.2 and earlier) should be converted first – 
using WBI Workbench version 4.2.3,  4.2.4, 4.2.4 Fix Pack1, or 4.2.4 Fix Pack1 
HotFix - to one of these versions before adding them to the WBI Workbench 
Server database. Refer to the WBI Workbench Server User Guide for more 
information about adding organizations to the database.

Important Note: The database migration to WBI Workbench Server 
4.2.4 Fix Pack1 HotFix can be done only if the existing database 
belongs to these  versions of WBI Workbench Server (v4.2.2, 
v4.2.3,  v4.2.4, and v4.2.4 Fix Pack1). If the existing database 
belongs to an earlier version than v4.2.2 (version 4.2.1 and before), 
then you cannot migrate the database directly to the current 
version. In this case you must upgrade your existing database 
incrementally to version 4.2.2, by using the InstallServer Utility of 
this version to keep the history of the  added processes versions. 
Afterwards, you can upgrade the database to the recent version of 
WBI Workbench Server.

Important Note: It is strongly recommended that you backup your 
existing database before you perform the migration steps.

The WBI Workbench Server upgrade must be performed in the following 
sequence:

1.   Un-deploy the existing version of WBI Workbench Server Application 
Server completely from the WebSphere Application Server. You can 
perform the un-deployment either automatically or manually. 
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Refer to the section entitled WBI Workbench Server Application Un-
Deployment in this chapter for the detailed steps of automatic un-
deployment of WBI Workbench Server Application. Refer also to the 
section with the same title in Appendix A: Manual Deployment of WBI 
Workbench Server on WebSphere 4.0.2 and Appendix B of this guide: 
Manual Deployment of WBI Workbench Server on WebSphere 5.0.of 
this guide for the detailed steps of the manual un-deployment of WBI 
Workbench Server Application.

2.   Uninstall the previous version of WBI Workbench Server. 

Refer to the section entitled WBI Workbench Server Un-installation in 
this chapter for the detailed steps of un-installing the WBI Workbench 
Server from your machine.

3.   Delete the <WBServerHomeDir> directory.

The above two steps of Uninstalling the previous version of WBI 
Workbench Server and  Deleting the <WBServerHomeDir> 
directory are optional but are recommended. You can keep the 
previous installation and the existing <WBServerHomeDir> 
directory, and then the installation of the new version will 
overwrite the contents of this directory. 

4.   Install the new version of the WBI Workbench Server on your machine 
using the WBI Workbench Server Installation Wizard. 

Refer to the contents of the install.html file that is delivered with the 
package for instructions about how to start the WBI Workbench Server 
Installation Wizard.

5.   Perform the Database Upgrade using the InstallServer utility. Refer to 
the section entitled Updating an Existing Database with a New Version 
in Chapter 2 Creating the WBI Workbench Server Database of the guide 
for the detailed steps of how to upgrade the existing WBI Workbench 
Server database.

Important Note: The database migration retains the code page of 
the upgraded database. That means if the existing database that 
belongs to v4.2.3 has a specific code page (for example IBM-1252), 
then the upgraded database will still have the same code page. 
Therefore, if you intend to make the database accept data with 
multiple languages, then you must convert the database to have 
UTF-8 code page either before or after the migration. Please 
consult your Database Administrator for information about 
converting the code page of an existing database.

6.   Deploy the WBI Workbench Server Application that belongs to the new 
version of WBI Workbench Server after completing the upgrade of the 
database.
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Refer to the section entitled Automated Deployment of WBI Workbench 
Server Application Server on WebSphere in this chapter for the detailed 
steps of automatic deployment of WBI Workbench Server Application 
Server. Refer also to Appendix A: Manual Deployment of WBI 
Workbench Server on WebSphere 4.0.2 and Appendix B: Manual 
Deployment of WBI Workbench Server on WebSphere 5.0.of this guide 
for the detailed steps of the manual deployment of WBI Workbench 
Server Application Server. 
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Appendix A: Manual Deployment of 
WBI Workbench Server 
on WebSphere 4.0.2

This appendix describes the manual steps of deploying WBI Workbench Server 
on IBM WebSphere 4.0.2. Before starting these steps, it is assumed that the 
WBI Workbench Server Database and Event Queue Database with their Table 
Spaces are created and configured in IBM DB2.

The following conventions are used for all the instructions throughout this 
document: 

• On AIX and Solaris platforms, use forward slash / instead of back-slash \ 
when writing paths 

• Important note: The names and paths of folders and files are case 
sensitive. 

• Important note: Make sure that the user you are using have all needed 
permissions. For example, using a user who has no permissions on 
WebSphere or the Database  will fail to deploy the WBI Workbench Server. 

• The following are a list of all abbreviations in the deployment steps:

*  <WebSphere> = The WebSphere home directory. e.g. 
C:\Websphere\AppServer 

*  <WBServerHomeDir> = The WBI Workbench Server home directory. 
e.g. C:\Workbench_Server

*  <WBServerWorkDir> = The WBI Workbench Server working 
directory. e.g. C:\BPR42

*  <WebServerName> = The name of the machine that hosts the Web 
server for which the WebSphere is configured. (Ex. The machine 
name on which the IBM HTTP Server or Microsoft IIS 4.0 or IIS 5.0 is 
installed) 

*  <ServerName> = The name of the server on which the WBI 
Workbench Server will be installed. 

*  <DB2> = The DB2 home directory. e.g. C:\SQLLIB 

*  <SQLSRVR> = The MS SQL Server database server installation 
root directory

*  <SQLJDBC> = The MS SQL Server JDBC driver installation directory. 
(e.g. C:\Apps\SQL200JDBC) 

*  <ORACLE_HOME> = The path where the Oracle Database Server is 
installed. (E.g. C:\Oracle\Ora81) 
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1 WBI Workbench Server 
Deployment 

1.1 Creating the Working Directory
In the Manual deployment of WBI Workbench Server, it is preferred to create a 
separate working directory other than the WBI Workbench Server home 
directory that was created after extracting the necessary folders and files 
through the WBI Workbench Server installation wizard (the default name and 
path of this home directory is C:\Workbench_Server). However, you can use the 
home to be your working directory, and in this case change all references in the 
coming deployment steps that refer to the Working Directory to be replaced with 
the Home Directory.

To create the WBI Workbench Server Working Directory and copy the needed 
files and folder inside it:

1.   Create a new folder with a different name from the home directory. (i.e. 
C:\BPR423 for Windows platform or /home/BPR423 for AIX and Solaris 
platforms)

2.   Inside this working directory, create three new folders named lib, server, 
and logs.

3.   Copy the following folders and files from the WBI Workbench Server 
Home Directory to the working directory you’ve just created as the 
following:

- Copy the contents of the <WBServerHomeDir>\was4-wizard\lib folder 
to <WBServerWorkDir>\lib

- Copy the  <WBServerHomeDir>\was4-wizard\server\BPR_Server.ear 
file to <WBServerWorkDir>\server

1.2 Adjust the WBI Workbench Server Parameters
The first thing you need to do in order to deploy WBI Workbench Server on 
WebSphere 4.0.2 is to adjust the WBI Workbench Server initial parameters. 
This can be done through the WebSphere Application Assembly Tool.

To adjust the WBI Workbench Server initial parameters:

1.   Start the WebSphere Administrator's Console.

2.   Select Tools >Application Assembly Tools from the menu.

The Application Assembly Tool window opens.

3.   Click Cancel to close the welcome screen.

4.   Select File> Open from the menu. 
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The Open dialog box appears.

5.   Select the BPR_Server.ear file located in <WBServerWorkDir>\server

6.   Expand the tree on the left and select Repository>Web Modules > All 
Products > Context Parameters.

7.   Adjust the values of each parameter in the Parameters list on the right 
by selecting the parameters and change the parameter’s value in the 
Parameter Value box.

- repDBUser: Type the user id for the user who can access the 
database and define new users
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*  For Oracle Database, it is preferably to use the WFBPR user that 
has been used to create the database tables.

- repDBPassword: Type the password for the user who can access the 
database and define new users 

- workingDir:, type the full path of the working directory ware the added 
organization files will be stored

- LDAPAuthMechanism: Type the LDAP authentication mechanism 
(simple)

- LDAPInitialContext: Type the LDAP Initial Context (e.g. 
com.sun.jndi.ldap.LdapCtxFactory)

- LDAPPort: Type the LDAP Server name and port number (e.g. ldap://
ldapsrvr:389/)

*  For AIX and Solaris platforms, type the LDAP server IP address 
instead of the server name

- dataSource: Type the WBI Workbench Server data source name (e.g. 
jdbc/BPRDataSource)

- databaseDriver: Type the database driver implementation class:

*  For IBM DB2, type: COM.ibm.db2.jdbc.app.DB2Driver

*  For MS SQL Server, type: 
com.microsoft.jdbc.sqlserver.SQLServerDriver

*  For Oracle, type: oracle.jdbc.driver.OracleDriver

- databaseURL: Type the database URL 

*  For IBM DB2, type: jdbc:db2:BPR

*  For MS SQL Server type: jdbc:microsoft:sqlserver://
<SQL_Server_Machine_Name>:<Port_Number>;DatabaseNa
me=BPR(e.g. jdbc:microsoft:sqlserver://
SQLMachine:1433;DatabaseName=BPR)

*  For Oracle, type: 
jdbc:oracle:thin:@<Oracle_Server_Machine_Name>:<Port_Nu
mber>:BPRORA1 (E.g. 
jdbc:oracle:thin:@OraMachine:1521:BPRORA1)

- dbconnectionOption: Type 0 if the database connection is local, or 1 
if the database connection is Distributed (using WebSphere Data 
Sources)

*  If the database connection is Distributed then the defined user 
name and password in the repDBUser and repDBPassword 
parameters will be ignored and the the user name and password 
that are defined for the data source in the application server will 
be used alternatively.

- initialContext: Type com.ibm.ejs.ns.jndi.CNInitialContextFactory

- postFieldDelimeter: Type the database post field delimiter (e.g. “]” for 
MS SQL Server, “ for Oracle, or empty for IBM DB2)
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- preFieldDelimeter Type the database pre field delimiter (e.g. “[” for 
MS SQL Server, “ for Oracle, or empty for IBM DB2).

- serverPort: Type the name and port number of the server where the 
WebSphere is installed. 
(e.g. iiop:/wassrvr:900/)

- SecurityMode: Type the Security type you have (type either local or 
ldap

- VersionReminder: Type 1 to display the version reminder message 
before checking out a process or 0 to hide this message.

- LDAP_User: Type a Distinguished Name (DN) for an LDAP Server 
authorized user that will be used for logging in to this LDAP Server, 
and performing the search in the LDAP users tree.

- LDAP_Password: Type the password of the defined User DN.

- LDAP_UID_Attribute: Type the name of the prefix that preceds the 
user ID in the LDAP Server database (i.e. CN, UID,...etc). The value of 
this parameter varies between the different types of LDAP Servers.

- LDAP_ROOT_DN: Type the starting point in the LDAP tree from which 
the query will start searching for the full DN of the given user ID.

- LDAP_DN_Attribute: Type the name of the Distinguished Name 
attribute ID (i.e. distinguishedName, entrydn, ...etc. This value is case 
sensitive).

You have to click Apply after changing each parameter to save 
your change.
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8.   Select Repository>Web Modules > All Products >Web Components 
> viewer > Initialization Parameters.

9.   Adjust the values of the following two parameter in the Parameters list 
on the right by selecting the parameters and change the parameter’s 
value in the Parameter Value box

- workingDir: Type <WBServerWorkDir>

- WebSphere: Type true

You have to click Apply after changing each parameter to save 
your change.

10.   Select File > Save from the menu to save the BPR_Server.ear.

11.   Exit the Application Assembly Tool and the WebSphere 
Administrator’s Console.

1.3 Configure IBM WebSphere 

In Windows NT or Windows 2000, make sure that the IBM WS 
AdminServer service is started and running.
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The purpose of these steps is to create and configure a new Application Server 
for WBI Workbench Server in WebSphere. 

In order to perform this operation, start the WebSphere Administrator’s 
Console and perform the following steps:

1.3.1 Create JDBC Provider and Data Sources

Create and Install the JDBC Provider

If a previous JDBC Provider  is already created and installed, then you can skip 
the following steps for creating and installing the database drivers for the data 
source.

1.   Create a JDBC Provider named BPRDBDriver: 

- Expand the WebSphere Administrative Domain tree, and select 
Resources > JDBC Providers

- Right-click the JDBC Providers and select New from the shortcut 
menu that appears.
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 The JDBC Provider Properties dialog box appears: 

*  Type BPR_Driver in the Name box. 

*  Click the Browse button (represented by triple dots) next to the 
Implementation Class field. The Select an Implementation 
Class dialog box appears.
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- For IBM DB2: Select 
COM.ibm.db2.jdbc.DB2ConnectionPoolDataSource 

- For Oracle: Select 
oracle.jdbc.pool.OracleConnectionPoolDataSource

- For MS SQL Server: Type the following class in the 
Implementation Class field in the JDBC Provider Properties 
dialog box:

com.microsoft.jdbcx.sqlserver.SQLServerDataSource

*  Click OK. The dialog box will close and you will return to the JDBC 
Provider Properties dialog box where the selected class appears 
in the Implementation Class field. 

2.   Install the BPR_Driver JDBC Driver: 

- While you are in the JDBC Provider Properties dialog box, select the 
Nodes tab.
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*  Click Install New, the Install Driver dialog box appears.
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*  Select <ServerName> from the Nodes list, and click Specify 
Driver in order to select a driver to be installed for the node. The 
Specify the Driver Files dialog box appears.

*  Click Add Driver. The Open dialog box appears.

*  Select the appropreate JDBC driver file for your database:

- For IBM DB2, select the file named db2java.zip located in the 
<DB2>\java12 folder

- For Oracle, select the file named classes12.zip located in the  
<ORACLE_HOME>\jdbc\lib folder.

- For MS SQL Server, select the files named mssqlserver.jar, 
msutil.jar, and msbase.jar located under the lib folder inside the 
SQL Server JDBC Driver installation folder 

You need to select each file in a single step
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- Click Open.

*  Select the added driver in the Specify the Driver Files dialog box 
and click Set.

*  Click Install in the Install Driver dialog box.

*  Click OK in the JDBC Provider Properties dialog box. The 
BPR_Driver will be created and installed.

Create the Data Source 

Create a data source to point to the Database and the Database Driver:

1.   Create a data sources named  BPR_DataSource: 

- Expand the WebSphere Administrative Domain tree, and select 
Resources > JDBC Providers > BPRDBDriver > Data Sources

- Right-click Data Sources and select New from the shortcut menu that 
appears. 
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The Data Source Properties dialog box appears: 

*  Type  BPR_DataSource in the Name box. 

*  Type  jdbc/BPR_DataSource in the JNDI name box. 

*  In the Custom Properties table:

*  For IBM DB2:

- Type BPR in the Database Name field. 

- Type the Database Administrator’s user name and password in 
the User and Password fields. (These two fields are optional).

*    For Oracle:

- Type 
jdbc:oracle:thin:@<Database_Machine_Name>:<Database_
Port_Number>:BPRORA1 in the URL field. 

- Type WFBPR in the the User field

- Type password in the Password field  (These two fields are 
optional).

*  For MS SQL Server: 

- Type BPR in the Database Name field. 
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- Type the Database Administrator's user name and password in 
the User and Password fields. (These two fields are optional).

- Type the server name and the port number of the server 
machine on which the MS SQL Server is installed in the 
serverName and portNumber fields respectively.

- Type cursor in the selectMethod field.

You can test the connection with the WBI Workbench Server 
Database with the entered user name or password by clicking Test 
Connection. If the Database name, user name or password is not 
correct, then you will be notified by a message. Otherwise, 
another message will confirm that the connection is successful.

1.3.2 Create a new Application Server 

Now your next step is to create a new Application Server for WBI Workbench 
Server. 

1.   In the WebSphere Administrative Domain tree, right-click Nodes > 
<ServerName> > Application Servers and select New from the 
shortcut menu that appears.  
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The Create Application Server dialog box appears.

- In the General tab: 

*  In the Application Server Name box, type  BPRAppServer . 

*  Select the <ServerName> node from the Node combo box if it is 
not displayed by default

*  In the Working Directory box, type <WBServerWorkDir> 

*  In the Module Visibility combo box, select Application.

*  Leave the other fields as default

- In the File tab:
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*  Leave the Standard Input box blank

*  In the Standard Output box, type logs/stdout.txt 

*  In the Standard Error box, type logs/stderr.txt 

*  Leave the check boxes in the File Permissions frame with their 
default settings.

- In the JVM Settings tab: 
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*  In the Initial java heap size box, type 64 

*  In the Maximum java heap size box, type 128 

*  In the Classpaths frame click Add, then type the following 
command line as a single line with no spaces in the field added 
under the Name column:

In AIX and Solaris platforms, replace the semicolon (;) with colon 
(:) 

For IBM DB2, Type:

<DB2>/java12/db2java.zip;<WebSphere>/lib/
J2ee.jar;<WebSphere>/lib/xerces.jar;<WBServerWorkDir>/lib/
security.jar;<WBServerWorkDir>/lib/
db.jar;<WBServerWorkDir>/lib/
WebSecurity.jar;<WBServerWorkDir>/lib/
publisher.jar;<WBServerWorkDir>/lib/
search.jar;<WBServerWorkDir>/lib/repository.jar
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For Oracle, Type:

<ORACLE_HOME>/jdbc/lib/classes12.zip;<WebSphere>/lib/
J2ee.jar;<WebSphere>/lib/xerces.jar ;<WBServerWorkDir>/lib/
security.jar ;<WBServerWorkDir>/lib/db.jar 
;<WBServerWorkDir>/lib/WebSecurity.jar 
;<WBServerWorkDir>/lib/publisher.jar;<WBServerWorkDir>/lib/
search.jar;<WBServerWorkDir>/lib/repository.jar

For MS SQL Server Type:

<WebSphere>/lib/J2ee.jar;<WebSphere>/lib/xerces.jar 
;<WBServerWorkDir>/lib/security.jar ;<WBServerWorkDir>/lib/
db.jar ;<WBServerWorkDir>/lib/WebSecurity.jar 
;<WBServerWorkDir>/lib/publisher.jar ;<SQLJDBC>/lib/sqldrv/
msutil.jar ;<SQLJDBC>/lib/sqldrv/msbase.jar ;<SQLJDBC>/lib/
sqldrv/mssqlserver.jar;<WBServerWorkDir>/lib/
search.jar;<WBServerWorkDir>/lib/repository.jar

*  In the System Properties frame click Add, a new blank row will 
be added in the System Properties table.

- Type default.client.encoding in the Name field.

- Type UTF-8 in the Value field.

- Click OK. The new application server will be created. 

1.3.3 Install the WBI Workbench Server Enterprise 
Application

Now you will create and install an Enterprise Application for WBI Workbench 
Server.

1.   From the Console > Wizards menu, select Install Enterprise 
Application.

The Install Enterprise Application Wizard will start

2.   In the Specifying the Application or Module screen: 
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- Select the <ServerName> node from the Browse for file on node: 
combo box if it is not displayed by default.

- Select the Install Application (*.ear) radio button.

- In the Application name box, type Repository
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- Click the Browse button to locate the BPR_Server.ear file. The Open 
dialog box appears. 

*  Select the  BPR_Server.ear file located in 
<WBServerWorkDir>\server. 

*  Click Open. The file will be selected and you will return to the 
Specifying the Application or Module screen

- Click Next.

3.   In the Mapping Users to Roles screen, click Next.

4.   In the Mapping EJB RunAs Roles to Users screen, click Next.

5.   In the Binding Enterprise Beans to JNDI Names screen, click Next.

6.   In the Mapping EJB References to Enterprise Beans screen, click 
Next.

7.   In the Mapping Resource References to Resources screen, click 
Next

8.   In the Specifying the Default DataSource for EJB Module screen, 
click Next.

9.   In the Specifying DataSources for Individual CMP Beans screen, 
click Next.

10.   In the Selecting Virtual Hosts for Web Modules screen, click Next.

11.   In the Selecting Application Server screen:
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- Select  All Products from the Module column.

- Click Select Server. The Select a Server or Server Group dialog box 
appears.
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- Select  BPRAppServer(<ServerName>) from the Application Server 
list and click OK.

- Click Next in the Selecting Application Server screen.

12.   In the Completing Application Installation Wizard screen, click 
Finish. 

The new Enterprise Application will be installed.

13.   Wait until the confirmation message appears, and then click OK. 

1.3.4 Regenerating Web Server Plug-in

Now you must regenerate the Web Server Plug-in to be adequate with the 
installed Enterprise Application. To regenerate the Web Server Plug-in:

1.   In the WebSphere Administrative Domain tree, right-click Nodes > 
<ServerName> and select Regen Webserver Plugin from the shortcut 
menu that appears. 
 76        IBM WBI Workbench Server - Deployment Guide



2.   Wait until the confirmation message appears, and then click OK.

3.   Restart the installed Web Server 

Example: If you installed IBM HTTP Server as the Web Server then do the 
following:

1.   From the Windows Taskbar, select Start > Programs > IBM HTTP 
Server > Stop IBM HTTP Server.

2.   Wait until the confirmation message that tells you that the IBM HTTP 
Server has been stopped.

3.   From the Windows Taskbar, select Start > Programs > IBM HTTP 
Server > Start IBM HTTP Server.

4.   Wait until the confirmation message that tells you that the IBM HTTP 
Server has been started.

1.3.5 Starting the Application Server

Now you must start the new Application Server. To do this: 

1.   In the WebSphere Administrative Domain tree, right-click Nodes > 
<ServerName> > Application Server >  BPRAppServer and select 
Start from the shortcut menu that appears.
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2.   Wait until the confirmation message appears, and then click OK.
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2 WBI Workbench Server 
Application Server Un-deployment 

This section is used to completely un-deploy the WBI Workbench Server 
Application Server. To completely un-deploy the WBI Workbench Server 
perform the following steps:

1.   Open the WebSphere Administrator’s Console. 

2.   In the WebSphere Administrative Domain tree, right click Nodes > 
<ServerName>> > Application Server >  BPRAppServer and select 
Stop from the shortcut menu that appears to stop the WBI Workbench 
Server Application Server. 

3.   In the WebSphere Administrative Domain tree, right click the 
Enterprise Applications > Repository and select Remove from the 
shortcut menu.

4.   Right click the Nodes > <ServerName>> > Application Server > 
BPRAppServer and select Remove from the shortcut menu.

5.   Remove the Data Sources (BPRDataSource).

6.   Uninstall and remove the BPRDriver database driver.

7.   Delete the file BPR_Server_deployed.ear from 
<WebSphere>\Appserver\InstallableApps\

8.   Delete all files in the <Server> folder.
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Appendix B: Manual Deployment of 
WBI Workbench Server 
on WebSphere 5.0 

This appendix describes the manual steps of deploying WBI Workbench Server 
on IBM WebSphere 5.0. Before starting these steps, it is assumed that the WBI 
Workbench Server Database and Event Queue Database with their Table 
Spaces are created and configured in IBM DB2.

The following conventions are used for all the instructions throughout this 
document: 

• On AIX and Solaris platforms, use forward slash / instead of back-slash \ 
when writing paths 

• Important note: The names and paths of folders and files are case 
sensitive. 

• Important note: Make sure that the user you are using have all needed 
permissions. For example, using a user who has no permissions on 
WebSphere or the Database  will fail to deploy the WBI Workbench Server. 

• The following are a list of all abbreviations in the deployment steps:

*  <WebSphere> = The WebSphere home directory. e.g. 
C:\Websphere\AppServer or C:\Websphere\DeploymentManager

*  <WBServerHomeDir> = The WBI Workbench Server home directory. 
e.g. C:\Workbench_Server

*  <WBServerWorkDir> = The WBI Workbench Server working 
directory. e.g. C:\BPR42

*  <WebServerName> = The name of the machine that hosts the Web 
server for which the WebSphere is configured. (Ex. The machine 
name on which the IBM HTTP Server or Microsoft IIS 4.0 or IIS 5.0 is 
installed) 

*  <ServerName> = The name of the server on which the WBI 
Workbench Server will be installed. 

*  <DB2> = The DB2 home directory. e.g. C:\SQLLIB 

*  <SQLSRVR> = The MS SQL Server database server installation 
root directory

*  <SQLJDBC> = The MS SQL Server JDBC driver installation directory. 
(e.g. C:\Apps\SQL200JDBC) 

*  <ORACLE_HOME> = The path where the Oracle Database Server is 
installed. (E.g. C:\Oracle\Ora81) 
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1 WBI Workbench Server 
Deployment 

1.1 Creating the Working Directory
In the Manual deployment of WBI Workbench Server, it is preferred to create a 
separate working directory other than the WBI Workbench Server home 
directory that was created after extracting the necessary folders and files 
through the WBI Workbench Server installation wizard (the default name and 
path of this home directory is C:\Workbench_Server). However, you can use the 
home to be your working directory, and in this case change all references in the 
coming deployment steps that refer to the Working Directory to be replaced with 
the Home Directory.

To create the WBI Workbench Server Working Directory and copy the needed 
files and folder inside it:

1.   Create a new folder with a different name from the home directory. (i.e. 
C:\BPR423 for Windows platform or /home/BPR423 for AIX and Solaris 
platforms)

2.   Inside this working directory, create three new folders named lib, server, 
and logs.

3.   Copy the following folders and files from the WBI Workbench Server 
Home Directory to the working directory you’ve just created as the 
following:

- Copy the contents of the <WBServerHomeDir>\was5-wizard\lib folder 
to <WBServerWorkDir>\lib

- Copy the  <WBServerHomeDir>\was5-wizard\server\BPR_Server.ear 
file to <WBServerWorkDir>\server

1.2 Configure IBM WebSphere 
The manual deployment of WBI Workbench Server on WebSphere is done 
through the IBM WebSphere Administrative Console for either WebSphere 
Application Server v5.0 or WebSphere Deployment Manager (Network 
Deployment) v5.0. The difference between the deployment steps on each of 
these WebSphere products is that in WebSphere Deployment Manager 
(Network Deployment) v5.0 you have to select the node on which you will 
create the Application Sever and deploy the WBI Workbench Server Enterprise 
Application. This is done at the beginning of each section steps that requires the 
node selection.

The following sections provide the detailed steps of the manual deployment of 
WBI Workbench Server on WebSphere:
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1.2.1 Create JDBC Provider and Data Sources 

Create and Install the JDBC Provider 

If a previous JDBC Provider is already created and installed, then you can skip 
the following steps for creating and installing the database drivers for the data 
source.

To create a JDBC Provider named BPRDBDriver: 

1.   From the left hand tree, select Resources > JDBC Providers. The 
JDBC Provider page appears in the right side of the window. 

2.   Click New. The JDBC Provider > New page appears.
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- Select the JDBC Driver type from the JDBC Providers drop down list:

- For IBM DB2 Database, select DB2 JDBC Provider

- For Oracle Database, select Oracle JDBC Thin driver.

- For MS SQL Server Database, select Microsoft JDBC driver for 
MSSQLServer 2000

3.   Click Apply, the configuration page of the selected JDBC Provider type 
appears.
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4.   Type BPR_Driver in the Name box. 

5.   Type a description for the new JDBC Provider in the Description box 
(Optional)

6.   In the Classpath box, change the contents of this field to contain the 
path and name of the JDBC Driver file according to your Database 
Server type:

- For IBM DB2, select the file named db2java.zip located in the 
<DB2>\java12 folder 

- For Oracle, select the file named classes12.zip located in the 
<ORACLE_HOME>\jdbc\lib folder 

- For MS SQL Server, select the files named mssqlserver.jar, msutil.jar, 
and msbase.jar located under the lib folder inside the SQL Server 
JDBC Driver installation folder 

You need to press Enter after typing the path and name of each 
file. 

- Click OK. 

- Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.
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- Click Save.

Create the Data Source 

To create a data source named BPR_DataSource to point to the Database and 
the JDBC Provider:

1.   From the left hand tree, select Resources > JDBC Providers. The 
JDBC Providers page appears on the right.

2.   From the Existing JDBC Provider list, click the Hyperlink of the 
BPR_Driver you have created. The configuration page of the 
BPR_Driver appears.

3.   From the Additional Properties section, click the Data Sources (Version 
4) hyperlink. The Data Sources (Version 4) page appears.

4.   Click New. The Configuration page of the new Data Source appears. 
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5.   Type BPR_DataSource in the Name box. 

6.   Type jdbc/BPRDataSource in the JNDI name box. 

7.   For the rest of the properties do the following:

- For IBM DB2: 

*  Type BPR in the Database Name field. 

*  Type the Database Administrator's user name and password in the 
Default User ID and Default Password fields.  

- For Oracle: 

*  Leave the Database Name field empty.

*  Type WFBPR in the User field 

*  Type the password of the WFBPR user in the Password field. 

- For MS SQL Server: 

*  Type BPR  in the Database Name field. 

*  Type the Database Administrator's user name and password in the 
Default User ID and Default Password fields. (These two fields 
are optional).

8.   Click Apply. The Additional Properties section appears in the bottom 
of the page.

9.   If you are using Oracle or MS SQL Server, click the Custom Properties 
hyperlink.

10.   In the Custom Properties page: 
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- For Oracle:

*  Click the URL property hyperlink. The URL Properties page 
appears.

*  In the Value field type 
jdbc:oracle:thin:@<Database_Machine_Name>:<Database_P
ort_Number>:BPRORA1 in the URL field.

*  Click Apply.

- For MS SQL Server:

*  Click the Server Name property hyperlink. The Server Name 
Properties page appears.

*  In the Value field type the server name.

*  Click Apply.

*  Click the Port Number property hyperlink. The Port Number 
Properties page appears.

*  In the Value field type the port number of the server machine on 
which the MS SQL Server is installed in the.

*  Click Apply.

*  Make sure that the value of the selectMethod property is cursor.

11.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.
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12.   Click Save.

1.2.2 Create a new Shared Library

1.   In the left hand tree expand the Environment node 

2.   Select the Shared Library hyperlink. The Shared Libraries page 
appears.
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3.   Click New. The configuration page of the new Shared Library appears.

4.   Type BPRLib in the Name box.

5.   Type a description for the new shared library in the Description box 
(Optional).

6.   In the Classpath box, enter the following files names and paths followed 
by Enter:

- For IBM DB2, Type:
<DB2>/java12/db2java.zip

<WBServerWorkDir>/lib/security.jar

<WBServerWorkDir>/lib/db.jar 

<WBServerWorkDir>/lib/WebSecurity.jar

<WBServerWorkDir>/lib/publisher.jar

<WBServerWorkDir>/lib/search.jar

<WBServerWorkDir>/lib/repository.jar

- For Oracle, Type:
<ORACLE_HOME>/jdbc/lib/classes12.zip

<WBServerWorkDir>/lib/security.jar

<WBServerWorkDir>/lib/db.jar

<WBServerWorkDir>/lib/WebSecurity.jar

<WBServerWorkDir>/lib/publisher.jar
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<WBServerWorkDir>/lib/search.jar

<WBServerWorkDir>/lib/repository.jar

- For MS SQL Server Type:
<WBServerWorkDir>/lib/security.jar

<WBServerWorkDir>/lib/db.jar

<WBServerWorkDir>/lib/WebSecurity.jar

<WBServerWorkDir>/lib/publisher.jar

<SQLJDBC>/lib/sqldrv/msutil.jar

<SQLJDBC>/lib/sqldrv/msbase.jar

<SQLJDBC>/lib/sqldrv/mssqlserver.jar

<WBServerWorkDir>/lib/search.jar

<WBServerWorkDir>/lib/repository.jar

7.   Click OK

8.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.
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9.   Click Save.

1.2.3 Create a new Application Server 

The following steps describe how to create a new Application Server named 
BPRAppServer, on which you will deploy the WBI Workbench Server Enterprise 
Application. 

You can skip creating this new Application Server and then you 
can deploy the WBI Workbench Server Enterprise Application on 
the Base Server (server1).

To create a new Application Server for WBI Workbench Server: 

1.   From the Left hand tree, expand the Servers node.

2.   Click the Application Servers hyperlink. The Application Servers 
page appears.
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3.   Click New. The Create New Application Server wizard appears.

4.   Type BPRAppServer in the Server name field.

5.   Leave the other fields with their default values. 

6.   Click Next. The Confirmation Page appears.
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7.   Click Finish. The new Application Server will be created and its name 
will be added to the Application Servers list in the Application 
Servers page.

8.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.

9.   Click Save.

1.2.4 Configuring the New Application Server 

After creating the BPRAppServer application Server, you need to configure its 
parameters. If you intend to deploy the WBI Workbench Server Enterprise 
Application on the default Application Server (Base Server) named server1, 
then it is preferable to adjust this Application Server with the settings in this 
section’s steps. However you can use the Base Server with its default settings.

To configure the BPRAppServer:

1.   From the Left hand tree, expand the Servers node.

2.   Click the Application Servers hyperlink. The Application Servers 
page appears.
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3.   Click the BPRAppServer hyperlink in the Application Servers list. The 
BPRAppServer Application Server Configuration Page appears.

4.   Click the Process Definition hyperlink. The Process Definition 
configuration page appears.

- In the Working Directory box, type <WBServerWorkDir> 

- Leave the other fields with their default values.
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- Click Apply.

- Click the Java Virtual Machine hyperlink. The Java Virtual Machine 
configuration page appears.

*  In the Initial heap size box, type 64 

*  In the Maximum heap size box, type 128 

*  In the Generic JVM arguments box, type 
-Ddefault.client.encoding=UTF-8

*  Click OK.

- Click the BPRAppServer hyperlink in the top of the page to return to 
the BPRAppServer Configuration Page.
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- Click the Logging and Tracing hyperlink. The Logging and Tracing 
configuration page appears.

- Click the JVM Logs hyperlink. The JVM Logs Configuration Page 
appears.
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*  In the System.out section change the value in the File Name field 
to contain the following: <WBServerWorkDir>/logs/
SystemOut.log 

*  In the System.err section change the value in the File Name field 
to contain the following: <WBServerWorkDir>/logs/
SystemErr.log 

*  Click OK.

5.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.

6.   Click Save.

In addition to the previous steps, the following steps should be done in case of 
deploying the WBI Workbench Server application on WebSphere Application 
Server 5.0 either on the base server (server1) or on a new Application Server. 
You don’t need to perform these steps in case of deploying the WBI Workbench 
Server application on WebSphere Deployment Manager 5.0 (Network 
Deployment).

1.   From the Left hand tree, expand the Servers node.

2.   Click the Application Servers hyperlink. The Application Servers 
page appears.

3.   Click the BPRAppServer (or the server1) hyperlink in the Application 
Servers list. The BPRAppServer Application Server Configuration 
Page appears.

4.   Click the Web Container hyperlink from the Additional Properties 
table. The Web Container page appears.

5.   Click the HTTP Transports hyperlink from the Additional Properties 
table. The HTTP Transports page appears.

6.   Click the asterisk (*) hyperlink in the last row of the HTTP Transports 
table.

7.   Click the Custom Properties hyperlink. The Custom Properties page 
opens.
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8.   Open the configuration page of property named 
MaxKeepAliveConnections  by clicking its hyperlink in the table.

- In case of deploying the WBI Workbench Server application on the 
base server (server1), if you don't find the 
MaxKeepAliveConnections property in custom properties page, then 
search for it in the other ports in HTTP transports page, if you don't find 
it then ignore these steps.

9.   In the Value field, increment the value of this property by 1 (i.e. if the 
value is 0 the change it to 1)

10.   Click OK.

11.   Click Save in the top menu bar to save your changes. The Save page 
appears.
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12.   Click Save.

1.2.5 Configure the Virtual Host

Now you should configure the default_host virtual host in order to add the 
server HTTP port to its Host Aliases list. These steps are done if you have 
created a new Application Server or if you will deploy the WBI Workbench 
Server Enterprise Application on the Base Server (server1) in case of  
WebSphere Deployment Manager 5.0 (Network Deployment). If you will deploy 
the WBI Workbench Server Enterprise Application on the Base Server (server1) 
for  WebSphere Application Server 5.0 then do not perform these steps.

To configure the Virtual Host:

1.   In the left hand tree, expand the Servers  node.

2.   Click the Application Servers hyperlink. The Application Servers 
page appears.

3.   Click the BPRAppServer hyperlink. The BPRAppServer configuration 
page appears.

4.   Click the Web Container hyperlink from the Additional Properties 
table. The Web Container page appears.

5.   Click the HTTP Transports hyperlink from the Additional Properties 
table. The HTTP Transports page appears.

6.   Click the * hyperlink in the First row of the HTTP Transports table.

7.   Copy the value in the Port field.

8.   In the left hand tree, expand the Environment node.

9.   Click the Virtual Hosts hyperlink. The Virtual Hosts configuration page 
appears.

10.   Click the default_host hyperlink in the hosts list. The default_host 
configuration page appears.

11.   Click the Host Aliases hyperlink in the Additional Properties table. 
The Host Aliases page appears.

12.   Click New. The Configuration page of the new Host Alias appears.

13.   Type * in the Host Name field

14.   Type the BPRAppServer HTTP Port Number that you’ve coppied in the 
Port field. 

15.   Click OK.

16.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.
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17.   Click Save.

1.2.6 Adjust the WBI Workbench Server Parameters 

Now you should adjust the WBI Workbench Server initial parameters. This is 
done through the WebSphere Application Assembly Tool.

To adjust the WBI Workbench Server initial parameters:

1.   Start the WebSphere Application Assembly Tool 

2.   Click Cancel to close the welcome screen. 

3.   Select File> Open from the menu. 
The Open dialog box appears.

4.   Select the BPR_Server.ear file located in <WBServerWorkDir>\server 
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5.   Expand the tree on the left and select Repository>Web Modules > All 
Products > Context Parameters.  

6.   Adjust the values of each parameter in the Parameters list on the right 
by selecting the parameters and change the parameter's value in the 
Parameter Value box. 

You have to click Apply after changing each parameter to save 
your change.

- repDBUser: Type the user id for the user who can access the 
database.

*  For Oracle Database, it is preferably to use the WFBPR that has 
been used to create the database tables.

- repDBPassword: Type the password for the user who can access the 
database.

- workingDir:, type the full path of the working directory.

- LDAPAuthMechanism: Type the LDAP authentication mechanism 
(simple) 
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- LDAPInitialContext: Type the LDAP Initial Context (e.g. 
com.sun.jndi.ldap.LdapCtxFactory) 

- LDAPPort: Type the LDAP Server name and port number (e.g. ldap://
ldapsrvr:389/) 

*  For AIX and Solaris platforms, type the LDAP server IP address 
instead of the server name 

- dataSource: Type the WBI Workbench Server data source name (e.g. 
jdbc/BPRDataSource) 

- databaseDriver: Type the database driver implementation class: 

*  For IBM DB2, type: COM.ibm.db2.jdbc.app.DB2Driver 

*  For MS SQL Server, type: 
com.microsoft.jdbc.sqlserver.SQLServerDriver 

*  For Oracle, type: oracle.jdbc.driver.OracleDriver 

- databaseURL: Type the database URL 

*  For IBM DB2, type: jdbc:db2:BPR 

*  For MS SQL Server type: jdbc:microsoft:sqlserver://
<SQL_Server_Machine_Name>:<Port_Number>;DatabaseNa
me=BPR (e.g. jdbc:microsoft:sqlserver://
SQLMachine:1433;DatabaseName=BPR) 

*  For Oracle, type: 
jdbc:oracle:thin:@<Oracle_Server_Machine_Name>:<Port_Nu
mber>:BPRORA1 (E.g. 
jdbc:oracle:thin:@OraMachine:1521:BPRORA1) 

- dbconnectionOption: Type 0 if the database connection is local, or 1 
if the database connection is Distributed (using WebSphere Data 
Sources).

*  If the database connection is Distributed then the defined user 
name and password in the repDBUser and repDBPassword 
parameters will be ignored and the the user name and password 
that are defined for the data source in the application server will 
be used alternatively.

- initialContext: Type 
com.ibm.websphere.naming.WsnInitialContextFactory

- postFieldDelimeter: Type the database post field delimiter (e.g. "]" for 
MS SQL Server, " for Oracle, or empty for IBM DB2) 

- preFieldDelimeter Type the database pre field delimiter (e.g. "[" for 
MS SQL Server, " for Oracle, or empty for IBM DB2). 

- serverPort: Type the name and port number of the server where the 
WebSphere is installed. 
The Server Port Number can be obtained for the application 
Server from the following location: 
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*  From the BPRAppServer Application Server Properties page, 
select the End Point property’s hyperlink.

*  Click the BOOTSTRAP ADDRESS end point name’s hyperlink.

*  The Port field contains the Server Port Number. Copy this number 
and use it for the serverPort parameter’s value.

- SecurityMode: Type the Security type you have (type either local or 
ldap 

- VersionReminder: Type 1 to display the version reminder message 
before checking out a process or 0 to hide this message.

- LDAP_User: Type a Distinguished Name (DN) for an LDAP Server 
authorized user that will be used for logging in to this LDAP Server, 
and performing the search in the LDAP users tree.

- LDAP_Password: Type the password of the defined User DN.

- LDAP_UID_Attribute: Type the name of the prefix that preceds the 
user ID in the LDAP Server database (i.e. CN, UID,...etc). The value of 
this parameter varies between the different types of LDAP Servers.

- LDAP_ROOT_DN: Type the starting point in the LDAP tree from which 
the query will start searching for the full DN of the given user ID.

- LDAP_DN_Attribute: Type the name of the Distinguished Name 
attribute ID (i.e. distinguishedName, entrydn, ...etc. This value is case 
sensitive).
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7.   Select Repository>Web Modules > All Products >Web Components 
> viewer > Initialization Parameters.

8.   Adjust the values of the following two parameter in the Parameters list 
on the right by selecting the parameters and change the parameter's 
value in the Parameter Value box 

You have to click Apply after changing each parameter to save 
your change.

- workingDir: Type /Pub 

- WebSphere: Type false 

9.   Select Repository>Web Modules > All Products >Web Components 
> jsp.
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10.   In the Component Type section, change the value of the Class name 
field to the following value:
com.ibm.ws.webcontainer.jsp.servlet.JspServlet

You have to click Apply after changing the parameter to save your 
change.

11.   Select File > Save from the menu to save the BPR_Server.ear. 

12.   Exit the Application Assembly Tool. 

1.2.7 Install the WBI Workbench Server Enterprise 
Application 

Now you will create and install an Enterprise Application for WBI Workbench 
Server.
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1.   From the left hand tree, expand the Applications node.

2.   Click the Install new Application hyperlink. The Preparing for the 
application installation wizard first page appears. 

3.   Click the Browse button to locate the BPR_Server.ear file. The Open 
dialog box appears. 

- Select the BPR_Server.ear file located in 
<WBServerWorkDir>\server. 

- Click Open. The file will be selected 

- Click Next.

4.   In the Generate Default Binding screen, click Next. The Install New 
Application wizard will start on its first step’s page.
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- In the Directory to Install Application field, enter the directory you 
want to be used for installing the WBI Workbench Enterprise 
Application. If you leave this field empty, then the default directory that 
WebSphere uses for installing the Enterprise Applications will be used 
(i.e. <WebSphere>\installedApps).

- Select the Use Binary Configuration check box.

- Leave the other settings with the default values.

- Click Next.

5.   In the Step 2 page (Map virtual hosts for web modules), Click next 
without changing any parameters.
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6.   In the Step 3 page (Map modules to application servers ) do the 
following:

- Select the Application Server on which you want to deploy the WBI 
Workbench Server Enterprise Application from the Clusters and 
Servers list. 
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- Select the check box next to the All Products module.

- Click Apply.

- Click Next.

7.   In Step 4 (Summary) the settings you have chosen will be listed. 
Review these settings. To return to any previous step, click the step 
number hyperlink and or click Finish if all settings are correct. 

8.   Wait until the installation is finished and the confirmation page appears

9.   Click Save to Master Configuration hyperlink to save your 
configuration. Then click Save in the confirmation message.

1.2.8 Assign the Created Shared Library to the Installed 
Enterprise Application

Now you should assign the BPRLib shared library that you have created before 
to the WBI Workbench Server Enterprise Application that you have just 
installed. To do this:

1.   In the left hand tree, expand the Applications node.

2.   Click the Enterprise Applications hyperlink. The Enterprise 
Applications page appears.

3.   Click the Repository hyperlink (or the name of the installed Enterprise 
Application of the WBI Workbench Server if you have changed the 
default name). The Repository Configuration Page appears.
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4.   Click the Libraries hyperlink from the Additional Properties table. The 
Library Ref page appears.
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5.   Click Add. The Configuration page of the new Shared Library 
Reference appears.

6.   Select the BPRLib shared library from the Library Name drop down list.

7.   Click OK.

8.   Click Save in the top menu bar to save your changes. The Save page 
appears.

For Network Deployment, it is preferred to select the Synchronize 
changes with nodes check box in the Save page.

9.   Click Save.

1.2.9 Regenerating Web Server Plug-in 

Now you must regenerate the Web Server Plug-in to be adequate with the 
installed Enterprise Application. To regenerate the Web Server Plug-in:

1.   In the left hand tree, expand the Environment node.

2.   Click the Update the Web Server Plugin hyperlink. The Update web 
server plugin configuration page appears.
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3.   Click OK. 

1.2.10 Restarting the Web Server

Now you should restart the Web Server you have.

Example: If you installed IBM HTTP Server as the Web Server then do the 
following:

1.   From the Windows Taskbar, select Start > Programs > IBM HTTP 
Server 1.3.26 > Stop IBM HTTP Server. 

2.   Wait until the confirmation message that tells you that the IBM HTTP 
Server has been stopped. 

3.   From the Windows Taskbar, select Start > Programs > IBM HTTP 
Server > Start IBM HTTP Server. 

4.   Wait until the confirmation message that tells you that the IBM HTTP 
Server has been started. 

1.2.11 Starting the Application Server 

Now you must start the new Application Server. To do this: 

For IBM WebSphere Application Server v5.0

1.   In Windows platform, run a command prompt window. In AIX or Solaris 
platforms start a console window.

2.   Change the directory to <WebSphere>\bin
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3.   Type the following command line:
startServer BPRAppServer

In AIX and Solaris platform type startServer.sh.

Where BPRAppServer is the Application Server on which the 
WBI Workbench Server Enterprise Application is deployed.

 This command is case sensitive.

4.   Wait until the Application Server is start and the confirmation message 
appears.

If you have deployed the WBI Workbench Server Enterprise 
Application on the Base Server named server1, then you need 
only to restart this server.

For IBM WebSphere Deployment Manager (Network 
Deployment) v5.0:

From the Administrative Console, do the following:

1.   From the left hand tree, select Servers > Application Server. The 
Application Servers page appears.

2.   Select the BPRAppServer Application Server by selecting the check 
box next to the Application Server’s name. And then click Start. 
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2 WBI Workbench Server 
Application Server Un-deployment 

This section is used to completely un-deploy the WBI Workbench Server 
Application Server. To completely un-deploy the WBI Workbench Server 
perform the following steps:

1.   Stop the BPRAppServer.

- For IBM WebSphere Application Server v5.0:

If you have deployed the WBI Workbench Server Enterprise 
Application on the Base Server named server1, then do not stop 
this Application Server.

*  In Windows platform, run a command prompt window. In AIX or 
Solaris platforms start a console window.

*  Change the directory to <WebSphere>\bin

*  Type the following command line:
stopServer BPRAppServer

In AIX and Solaris platforms type stopServer.sh 

Where BPRAppServer is the Application Server on which 
the WBI Workbench Server Enterprise Application is 
deployed.

This command is case sensitive.

- Wait until the Application Server is stopped and the confirmation 
message appears.

- For IBM WebSphere Deployment Manager (Network Deployment) 
v5.0:

*  From the Administrative Console, select Servers > Application 
Server from the left hand tree. The Application Servers page 
appears.

*  Select the BPRAppServer Application Server by selecting the 
check box next to the Application Server’s name.

*  Click Stop. 

2.   Open the WebSphere Administrative Console. 

3.   Uninstall the WBI Workbench Enterprise Application (the default name is 
Repository).
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- From the left hand tree, select Applications > Enterprise Applications.

- Select the check box next to the Repository Enterprise Application 
Server name.

- Click Uninstall.

4.   Delete the HTTP Port that you have added to the Host Aliases list.

5.   Delete the BPRAppServer Application Server.

- If you have deployed the WBI Workbench Server Enterprise 
Application on the Base Server named server1, then do not delete the 
server1 Application Server.

- For IBM WebSphere Application Server v5.0 only, If you have deployed 
the WBI Workbench Server Enterprise Application on the Base Server 
named server1, then decrease the value of the property named 
MaxKeepAliveConnections  and located in Application Servers > 
server1 > Web Container > HTTP Transports > <LastPortInTable> 
> Custom Properties by 1 (i.e. if you have increased the value during 
the deployment to be 1 then change it to 0 again).

6.   Delete the added BPRLib shared library.

7.   Delete the BPR_DataSource data source.

8.   Delete the BPR_Driver JDBC Provider

9.   Save your changes.

If you have deployed the WBI Workbench Server Enterprise 
Application on the Base Server named server1, then restart this 
Application Server.
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Appendix C: Using the AdminWrite 
Utility

This appendix describes how to use the AdminWrite utility in order to gather the 
required parameters needed for running the InstallServer utility. This is done if 
the InstallServer utility could not find the control.dat file that contains these 
required parameters.

The AdminWrite utility starts by running the file named AdminWrite.bat on 
Windows platform or the file named AdminWrite.sh on AIX and Solaris 
platforms. These files are located in <WBServerHomeDir>\installserver.

Before starting the AdminWrite utility, if the java.exe on Windows platform or the 
jave on AIX and Solaris platforms is not in your enironment variable path, then 
you have to edit the AdminWrite.bat file or the AdminWrite.sh file in order to 
adjust the path of  java.exe or java. To do this: 

1.   Open the AdminWrite.bat (or the AdminWrite.sh) for edit.

2.   Edit the classpath line to add the actual path of the java.exe or the java 
(the Java home directory) before it. 

Example:

If you are using the JDK that is shipped with the IBM WebSphere 
Application Server, then you should adjust the classpath line to start 
with <WebSphere>\java\bin\java.exe on Windows platform or 
<WebSphere>/java/bin/java on AIX and Solaris platforms. 

Where <WebSphere> is the IBM WebSphere Application Server 
Home Directory (i.e. C:\WebSphere\AppServer).

3.   Save and close the AdminWrite.bat (or the AdminWrite.sh) file.
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By running the AdminWrite.bat or AdminWrite.sh files, the AdminWrite utility 
will start and the InstallServer Parameters Version 4.2.3 dialog box appears:

1.   In the Database Directory field, enter the WBI Workbench Server 
database directory.

- This field is editable only if the database type is DB2.

- On Windows platform, enter only the drive name on which the 
database will be created (i.e. C: or C:\).

- On AIX and Solaris platforms, enter the full path and name of the 
directory in which the WBI Workbench Server database will be 
created. You must have write access on this directory and it must has 
enough space for the database creation.  

2.   Select the Database Type from the DB Type combo box.

3.   Enter the User ID of the database administrator who will create the WBI 
Workbench Server database in the User ID box.

4.   Enter the Database Administrator’s password in the Password box.

5.   Confirm the password by re-typing it in the Confirm Password box.

6.   Select the WBI Workbench Server security type (Local or LDAP) from 
the Security Mode combo box.

7.   Click OK. The entered parameters will be saved and the Install Server 
utility will be ready to use these parameters.
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Notices and Trademarks
US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA 
ADP Schedule Contract with IBM Corp.

Notices

IBM may not offer the products, services, or features discussed in this document in all 
countries. Consult your local IBM representative for information on the products and services 
currently available in your area. Any reference to an IBM product, program, or service is not 
intended to state or imply that only that IBM product, program, or service may be used. Any 
functionally equivalent product, program, or service that does not infringe any IBM intellectual 
property right may be used instead. However, it is the user’s responsibility to evaluate and 
verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in 
this document. The furnishing of this document does not give you any license to these 
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION “AS IS”...WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain transactions; 
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or changes in the product(s) 
and/or program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only 
and do not in any manner serve as an endorsement of those Web sites. The materials at 
those Web sites are not part of the materials for this IBM product and use of those Web sites 
is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: 
(i) the exchange of information between independently created programs and other programs 
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(including this one) and (ii) the mutual use of the information which has been exchanged, 
should contact:

WebSphere Business Integration Lab Director
IBM RTP Laboratory
3039 Cornwallis Road
P.O. BOX 12195
Raleigh, NC 27709-2195
U.S.A

Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. Some 
measurements may have been made on development-level systems and there is no 
guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurement may have been estimated through extrapolation. Actual 
results may vary. Users of this document should verify the applicable data for their specific 
environment.

Information concerning non-IBM products was obtained from the suppliers of those products, 
their published announcements or other publicly available sources. IBM has not necessarily 
tested those products and cannot confirm the accuracy of performance, compatibility or any 
other claims related to non-IBM products. Questions on the capabilities of non-IBM products 
should be addressed to the suppliers of those products.

This information may contain examples of data and reports used in daily business operations. 
To illustrate them as completely as possible, the examples may include the names of 
individuals, companies, brands, and products. All of these names are fictitious and any 
similarity to the names and addresses used by an actual business enterprise is entirely 
coincidental.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only.

COPYRIGHT LICENSE:

This information may contain sample application programs in source language, which 
illustrates programming techniques on various operating platforms. You may copy, modify, 
and distribute these sample programs in any form without payment to IBM, for the purposes 
of developing, using, marketing or distributing application programs conforming to the 
application programming interface for the operating platform for which the sample programs 
are written. These examples have not been thoroughly tested under all conditions. IBM, 
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
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Programming interface information

Programming interface information, if provided, is intended to help you create application 
software using this program. 

General-use programming interfaces allow you to write application software that obtain the 
services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning information. 
Diagnosis, modification and tuning information is provided to help you debug your application 
software.

Warning: Do not use this diagnosis, modification, and tuning information as a programming 
interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International Business 
Machines Corporation in the United States or other countries, or both:

Lotus is a trademark of International Business Machines Corporation and Lotus Development 
Corporation in the United States, other countries, or both.

Rational is a trademark of International Business Machines Corporation and Rational 
Software Corporation, in the United States, other countries or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft 
Corporation in the United States, other countries, or both.

MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other 
countries, or both.

Solaris, Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.

IBM
the IBM logo
AIX
AIX 5L
e-Business (Logo)
CrossWorlds
DB2
DB2 Universal Database

MQSeries
WebSphere
OS/2
OS/390
z/OS
Rational
RS/6000
XDE
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